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Textovy editor obohateny o grafické prvky
Technicka dokumentacia

1 Uvod

Sucasné textové editory zdrojovych kdédov len minimélne vyuzivaji moznosti grafickej
reprezentacie, ¢o je velka skoda vzhladom na to, ze prave obohatenie editorov o grafické
prvky by mohlo v mnohych veciach ul'ah¢it’ pracu s takymto editorom. Sprehladnil by sa
zdrojovy kod, zjednoduSila a zefektivnila nie len jeho tvorba, ale aj Uidrzba a prezentécia,

a vnieslo by to moznost’ nového pohl'adu na integraciu dokumentacie s programom.

Prave to by malo byt vysledkom tohto projektu, ktorého cielom bude pokracovat’ vo vyvoji
multiplatformového editora ,,TrollEdit* (ktory bol rieSeni v roku 2009/10 timom s nazvom
UFOPAK) pre editovanie najmé zdrojovych koédov, ktory bude vyuzivat' grafické prvky na
zjednoduSenie a zefektivnenie prace programatora. Nasim zameranim bude rozSirenie

stavajucej funkcionality do podoby vhodnej pre redlne nasadenie editora do praxe.

Tento dokument obsahuje zhrnutie vSetkych rieSeni nasho timu na tomto projekte od

analyzy az po implementéciu.
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2 Analyza

V ramci tejto Casti sme sa zamerali na analyzu existujiiceho rieSenia nie len z pohl'adu toho,
¢o vsetko uz editor dokaze, pripadne nedokéaze, ale boli analyzované aj kI'icové funkcionality,

ktoré by sme radi do editora zakomponovali.

2.1 Existujuce rieSenia editorov

V stiCasnosti na trhu existuje mnoho editorov od jednoduchsich az po zlozitejsie, s roznymi
funkcionalitami a metodami ktoré ul'ahcuji pracu pouzivatela. Pri vytvarani projektu sa

mdzeme inSpirovat’ si¢asnymi ako su eTextEditor (e), SciTE alebo Notepad++.

2.1.1 eTextEditor (e)

Textovy editor pre Microsoft Windows s vykonnymi funkciami pre upravu textu. Vznikol ako
alternativa pre TextMate, pretoze prave tento editor bol oslavovany mnohymi programatormi.
Umoziuje rychlu a jednoduchti manipulaciu s textom, automatizuje vSetku manualnu pracu,
¢im vam napomaha lepSiemu sustredeniu sa na pisanie. Medzi jeho pozoruhodné vlastnosti
patri osobny systém pre spravu revizii, rozvetvené, viacstupnové, grafické undo, moznost’
prevadzkovat TextMate zvdzkov pomocou Cygwin. Vyznamny prvok propagicie a
marketingu ,,e“ je jeho schopnost’ pustat mnoho TextMate zvizkov priamo z repozitara

MacroMates CVS.

B podporuje viacndsobny vyber textu. Ak je podrzany kldves Ctrl, potom
dvojklik/viacndsobny vyber slov, je vtedy mozné editovat’ vSetky tieto slova naraz. Vlastnost’
najst’ a premiestnit, dava okamziti vizudlnu spétnt vizbu, zvyraznenie poziadaviek, ktoré su
pisané. Tato vlastnost’ je uzitocna najma pri pouzivani regularnych vyrazov. Ked’ze vac¢sina
zvazkovych prikazov sa spolieha na Unixové prikazy, ktoré nie s k dispozicii pre Windows,

e pouziva sadu néstrojov Cygwin. MenSou nevyhodou je trosku pomalé otvaranie suborov.

2.1.2 SciTE

Editor zaloZeny na Scintille. V SciTE nenajdete ziadneho spravcu suborov, Project Manager
¢i integrovaného FTP klienta, je to teda Cisty editor. SciTE moze drZat’ viac siborov v paméti
naraz, priCom len jeden subor bude viditeI'ny. SciTE zvyraziuje syntax a podporuje mnozstvo
jazykov (HTML, PHP, SQL, CSS, Java, . . . ). M4 otvoreny zdrojovy kod. Obdiznikové bloky

textov je mozné vybrat’ podrzanim klavesy Alt, zatial’ ¢o je mys tahané ponad text. Pouzivaju
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sa rozne funkcie ako skratky, napoveda, editacné moznosti, vyhl'addvanie, pohyb kurzora,

kompilacia, dopiianie textu, makra, komentére, zobrazenie vystupu.
Tu uvadzame kratky prehl'ad zadkladnych a ¢asto pouzivanych vlastnosti:

Skratky: Napisete slovo, stlacite kldvesu Ctrl+B a rozvinie sa skratka, napr. if mdze byt
namapovang, ako if (|) {\n\t|\n}. Ich vyuzitie je efektivne z hladiska ¢asu, ak ozna¢ime kus

kodu, stlacime klavesy Ctrl+Shift+R, napiSeme if a kod sa obali kompletnou konstrukciou if.

Napoveda: Klaves F1 zobrazi napovedu k funkcii, na ktorej je kurzor. Aj tu je moznost

namapovat si pre 'ubovolny jazyk to, ¢o vdm najviac vyhovuje.

Editacné moZznosti: Zikladné editacné moznosti s samozrejmostou. Duplikacia riadka

pomocou Ctrl+D ¢i jeho prehodenie s predchadzajiucim riadkom Ctrl+T.

VyhPadavanie: Ctrl+F3 vyhlad4d slovo pod kurzorom alebo oznaceny text. Ctrl+Shift+F
vyhl'adava vo viac suboroch Standardnymi nastrojmi grep alebo findstr. Je mozné doplnit’ si aj
vlastnt funkciu na vyhladdvanie, teda moZzete napriklad vyhl'adavat’ len v retazcoch a text

najdeny inde sa odignoruje.

Pohyb kurzora: Klavesova skratka Ctrl+E presunie kurzor k odpovedajucej zatvorke.
Sikovna je aj funkcia pre prechod medzi ¢astami slov, na rozdiel od Ctrl+3ipky zohl'adiuje aj
podtrznik a zmeny velkosti pismen v slove ¢i odseku (bloky textu oddelené prazdnym

riadkom).
Kompilacia: Skontrolovanie syntaxe a prenesenie na riadok, kde sa danéa chyba nachadza.

Dopinanie textu: Ctrl+Space doplni slovo z pevného zoznamu a Ctrl+Enter potom zo slov

obsiahnutych v zozname.
Makra: Funk¢nosti je mozné rozSirovat’ makrami pisanymi v jazyku Lua.

Komentare: Ctrl+Q prehodi zakomentovanost oznacenych riadkov, Ctrl+Shift+Q

zakomentuje oznaceny text.

Zobrazenie vystupu: Vystup externych programov sa zobrazuje v samostatnom okne priamo

v ramci editora. Okno sa da zapnit’ ¢i vypnut’ pomocou klavesy F8.
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2.1.3 Notepad++

Volne dostupny editor zdrojového kodu [4], ktory aj podporou viacerych jazykov nahradza
Notepad. Bezi v prostredi MS Windows pod licenciou GPL. AvSak moéze byt
viacplatformovym vyuzitim softvéru, napr. WINE. Je zaloZzeny na komponente Scintilla
anapisany v jazyku C++ a vyuziva Cist¢ Win32 API a STL, ktoré zabezpecCuje vysSiu

rychlost’ a mensiu vel'kost’ programu.

Podporuje zvyraznenie syntaxe pre 44 jazykov, skriptovacie a znackovacie jazyky. UZivatelia
mozu tiez definovat’ svoj vlastny jazyk pomocou zabudovaného zasuvného panelu. Pre
vacsinu podporovanych jazykov mdéze uzivatel urobit’ svoj vlastny zoznam API (alebo
stiahnut’ API stibory zo sekcie). Akonahle je API stbor pripraveny, zadajte Ctrl+Space na

zacatie tejto akcie.

Podporuje multi-dokument, ¢o umoziuje upravu viacerych dokumentov naraz. Poskytuje dva
pohlady v rovnakom ¢ase. To znamend, Ze moZete zobrazit' dva rozne dokumenty sucasne.
Mozete vizualizovat' (editovat) v dvoch nahladoch jeden dokument a v dvoch roznych

poziciach. Uprava dokumentu v jednom zobrazeni sa bude vykonavat’ v inom néhl'ade.

Hradanie a nahradzanie retazca v dokumente pomocou regularnych vyrazov. Uplna podpora
drag-and-drop. MozZete otvorit dokument pomocou tejto funkcie, presunut’ tak dokument z
pozicie. UZivatel si mdZe nastavit poziciu pohladov dynamicky (len v reZzime dvoch
zobrazeni: oddel'ova¢ moze byt nastaveny horizontalne alebo vertikalne). Ak mate upravit’ ¢i
vymazat’ subor, ktory sa otvoril v Notepad++, ste upozorneni na aktualizaciu dokumentu
(reload subor alebo odstranenie suboru). Moznost’ funkcie priblizenia a oddialenia, ktora je

zloZkou Scintilly.

Podporuje viacjazycné prostredie. TakZe je mozné pouzivat’ napriklad aj ¢instinu, hebrejCinu,
korej¢inu ¢i arabCinu. Poskytuje funkciu zalozky, kde si uzivatel mdéze kliknut’ na rozpdtie
alebo pomocou Ctrl+F2 prepinat’ navestia. Pre dosiahnutie zaloziek staci stlacit’ F2 (d’alSie
zalozky), alebo Shift+F2 (predchadzajica zalozka). Vymazanie vSetkych zdloziek sa kona
pomocou Menu, kde kliknete na Hladat’ -> Odstranit’ vSetky zalozky. Ak vsuvka zostane pri
jednom zo symbolov {}()[], symbol vedla vsuvky a jeho opak budu zvyraznené, rovnako ako

smernice za uc¢elom l'ahSicho najdenia bloku.
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Tab. 1 Porovnanie funkcionalit

TextEditor (¢) | SciTE Notepad++
Spell checking plugin nie plugin
Viacnasobné undo/redo ano ano ano
Selekcie blokov ano ano ano
Zvyraznenie syntaxe ano ano ano
Automatické doplnanie ano ano ano
Integracia kompilatora ano ano ano
Spolo¢né editovanie na viacerych pocitacoch ano nie plugin

2.2

Analyza predchadzajuceho rieSenia nastroja TrollEdit

Vzhl'adom na to, ze pokraCujeme na projekte, ktory bol vyvijany v ramci minuloro¢ného

timového projektu bolo nutné vykonat podrobnu analyzu predchadzajiceho rieSenia.

Vysledkom je porovnanie medzi redlnym stavom editora a technickou dokumentéciou

minulého timu. Sprava o stave bola rozdelena podl'a jednotlivych funkénych Casti.

2.2.1 Inicializacia editora, otvorenie siborov

Implementované:

Chyba:

pri nacitani suboru urcenie spravnej gramatiky a jej kontrola
pri otvoreni suboru automatickd analyza a zobrazenie do blokov
o komentare st prepojené v blokoch avSak umiestnené st mimo riadku, na ktory
sa odvolavaju, bolo by vhodné ich umiestnit’ vedl'a textu
historia naposledy otvorenych stiborov
obsahuje modul pre syntakticka analyzu

novsia Lualit verzia — rychle spracovanie mensich stiborov

vel'ké stibory stale dost’ pomalé na pracu
pri otvoreni napr. Analyzer.cpp nevyrobi spravne bloky Casti stiboru, vSetko brané ako
samostatny riadok

2.2.2 Pracas editorom

Implementované:

zvyraziiovanie syntaxe az na urovni blokov, teda je mozné uréit’ grafické vlastnosti pre
y Yy )

vSeobecné prvky naprie¢ viacerym jazykom a gramatikdm

popis zvyraziiovania jednotlivych blokov, ktoré maji byt zvyraznené, je obsiahnuty

v konfiguracnom subore
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Chyba:

224

vSetko v ramci edita¢ného okna editora je mozné prestvat’

existuje moznost ,, Edit plain text” pre upravu textu, vtedy je zobrazené
v samostatnom okne vSetko ako Cisty text

v stibore text_item.cpp implementovany pohyb medzi blokmi po stlaceni klaves
samostatné zoomovanie kazdého otvoreného suboru nehl'adiac na tie ostatné
prestuvanie blokov v editore

vyhladavanie v texte zobrazi bloky, v ktorych sa text nachadza

klavesové skratky vel'mi chybaji

o nejaké uz su implementované (v Menu -> File sa daju vidiet))

o priamo na zaciatku v suibore main_window.cpp sa prirad’uju skratky k akcidm

chyba moznost’ Undo, Redo, Copy, Paste

o len cez kontextovi ponuku cez pravé tlacitko je moZna

selekcia textu aj v ramci viacerych blokov
malé moZnosti vyhl'addvania

o chyba moZnost' pri velkych stboroch krokovania ndajdenych vyskytov
vyhladavania

o vyhladava len v aktualnom subore

o lupa nie je klikateI'né tlacitko

naraz otvorena len jedna pracovna plocha (workspace)

o triedu BlockGroup je v buducnosti mozné vyuzit' na paralelné zobrazenie
viacerych hierarchii (BlockGroup) na jednej scéne (DocScene) — viacero
pracovnych pléch

konfigura¢ny subor sa nacita len raz, pri spusteni editora (sprevadza ho)
zakladna Struktura menu pre pracu stextom aoptions je zakomentovand a

neimplementovana

Programovanie v editore

analyza zdrojového kodu je casovo naro¢nejsia a preto sa spusta iba v case prechodu
pisania na d’al$i riadok.
funguje automatické odsadzovanie pri analyze
o medzery a tabuldtory sa nezobrazuju a realizuju sa len ako prazdny priestor
pred prislusnym blokom
o prebytocné zbavenie sa medzier

znak konca riadku je nahradeny nastavenim priznaku v bloku

Komentare

Implementované:

postvanie komentarov — plavajice komentare
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funguje zobrazenie jednoriadkovych aj blokovych komentarov ako samostatny blok
Sipka ku blokovému komentaru zac¢ina vzdy na zaciatku riadku

Sipka ku jednoriadkovému komentaru zacina od konca daného riadku

funguje CTRL + Lavé tladitko mySi = vytvori na danom mieste novy ale len bezny
blok (podobny ako ten pre komentar), pricom ho prepoji Sipkou z miestom kde sa

nachadzal kurzor

textové komentare ako samostatné bloky, nie je mozné napisat’ tvrdi medzeru

Sipka by mohla byt aj zmysluplnejsie ukazujuca na dany blokovy komentar

textové komentare len ako bezné bloky, nie je moznost’ rovno pisat’ dokumentaciu ako
bolo spominané cez dokumentacné bloky

chyba moznost’ vytvarania dokumentacnych blokov, ale funkéne je implementovana

2.2.5 Bloky

Implementované:

Chyba:

moznost’ prestivat’ bloky, alebo ¢asti blokov

pomocna ¢iara pri presune

plavajuce bloky sa nedaji zmazat’ priamo, jedine postupnym vymazanim ich obsahu
chyba mozZnost’ samostatne vytvarat’ bloky a prepajacie Sipky

Sipka odkazuje len na jeden blok

vzdy moZzné presuvat’ len jeden blok naraz, chyba vyber viacerych blokov

chyba skryvanie blokov, nezobrazuje moznost’ na skrytie blokov

pri inicializécii sa nedeteguje prekryvanie viacerych blokov na jednom mieste

pri vkladani bloku rozostupovanie ostatnych blokov

2.2.6 Praca so subormi, prilohami

Implementované:

pridanie stboru ako prilohy v podobe bloku,
o treba mat’ oznaceny nejaky blok, aby bolo mozné urcit’ Cast’ suboru od ktorej sa
prirad’uje
prilohy vklada ako odkaz
obrazky vie rovno zobrazit’
moznost’ upravy rozmerov obrazka
ukladanie ako povodny subor s komentdrmi, subor bez komentdrov, alebo ako PDF
tlacit’ (len printscreen v ramci ohranicenia pri tlaci)
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o ziadne pokrocilé prvky popisujiice obsah dokumentacnych blokov ako bolo
spominané

2.2.7 Syntakticky analyzator

Implementované:

e analyza realizovana v jazyku LUA za pomoci kniznice LPeg
o moznost’ roz§irovania o d’alSie gramatiky (nacitavaju sa z prieCinka grammars)
o vystupom je LUA tabul'ka obsahujuca d’alSie tabulky a tento systém tabuliek
zodpoveda syntaktickému stromu

e vytvaranie AST na strane jazyka LUA a jeho prenos do C++
2.2.8 Gramatika

Implementované:

e zékladna gramatika default grammar.lua
o rozlozenie 'ubovol'ného textu na slova a riadky
o popisané povinné konstanty, ktoré musia gramatiky obsahovat’
o funkcie na testovanie gramatik

e gramatika pre C, LUA a XML

2.2.9 Literate programming

Implementované:

e moznost vkladat’ ku kddu okrem klasickych komentarov aj obrazky
Chyba:

¢ neukladaji sa pridané obrazky a iné formatovacie zmeny v dokumente

e ukladanie dokumentacie do RTF formatu

2.3 Analyza pouzitych technologii
Pri implementacii budeme pouZzivat’ nastroje a technoldgie, ktoré pouzival predchadzajici tim
UFOPAK pocas vyvoja editora. Nosnymi technologiami si Qt SDK, Lua a vyuzitie RTF,

ktoré v skratke predstavime ako aj dovod, pre¢o sme sa rozhodli pokraovat’ v ich pouzivani.

23.1 Qt

Qt je implementacny ndstroj zaloZeny na jazyku C++. Je to technologia, pomocou ktorej je
mozné vyvijat’ aplikécie pre rozne platformy. Qt umoziuje vytvarat’ a jednoducho nasadzovat’
aplikécie pre pocitace, mobilné telefony, ale aj vnorené systémy (MP3prehravace), beziace

pod operacnymi systémami Windows, Linux, MAC OS, Symbian. Multiplatformovost’ je
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prave jedna z rozhodujucich vyhod, kvoli ktorym je editor implementovany pomocou tohto

nastroja. Qt je v sucasnosti dostupné pod komercnou ale aj GNU GPL v3.0 licenciou.

Nastroj Qt ponuka okrem mnozstva tried a kniznic pre tvorbu GUI aplikécii aj vlastné
vyvojové prostredie Qt Creator. UvaZované moZnosti prace s nastrojom Qt boli nasledovné:

e (Qt modul pre vyvojové prostredie Eclipse

e Qt modul pre vyvojové prostredie Visual Studio

e Integrované vyvojové prostredie Qt Creator

Rozhodli sme sa pre pouzitie prostredia Qt Creator, ked’ze poskytuje samostatné vyvojové
prostredie, Cize pre naSe potreby by malo byt ideédlne, a taktieZ integruje v sebe viacero
novSich technologii a pristupov, ktoré nam pomoézu pri vyvoji. Napr. obsahuje nova

technologiu Qt Quick.

2.3.2 Qt Quick a jazyk QML

Qt Quick je nova technoldgia uréend pre rychle vytvaranie jednoduchych a bohatych
pouzivatel'skych rozhrani aplikécii pre rozne platformy. Qt Quick obsahuje jazyk QML, ktory
je navrhnuty vychadzajtc z jazykov HTML, CSS, JavaScript, priCom spdja ich vyhody.

S pouzitim technoldgie Qt Quick je mozne aby dizajnér navrhol Ul podla vlastnej fantazie
a vyvojar len doplnil logiku aplikacie, ¢o prindSa obrovsku vyhodu ked’ze vyvojar a dizajnér
maju kazdy iny pohlad na svet anie vzdy bolo mozne najst konsenzus pri vytvarani

aplikacie.

Work together

QtQuick Designer ; . oML

Designer Developer
p— ==

Obr. 1 Pracovny cyklus s pouzitym Qt Quick
Qt Quick umoznuje vytvarat’ rézne animacie, ktoré vyuzivaji kniznicu OpenGL. Takisto
umoznuje navrhnit’ dizajn jednotlivych pouzivatel'skych prvkov aplikécie ako napr. tlacitka

v grafickych editoroch Adobe Photoshop, Autodesk Maya, Gimp.
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Jednoduchost’ technologie Quick mozno vidiet’ v rozdiele medzi definovanim jednoduchého

tlacitka klasickym spdsobom cez actionscript a novym pomocou jazyka QML.
Actionscript: MenuButton.as

public class MenuButton extends MovieClip
public function MenuButton () {
this.x = 60;
this.addEventListener (MouseEvent .MOUSE DOWN,
ClickBt) ;
1
function ClickBt (e:MouseEvent) ({
trace (“clicked”) ;
}
}

QtQuick: MenuButton.gml

Item {
x:60;
MouseArea: {
anchors.fill: parent;
onClicked: print("clicked");

}

Pouzitie technoldgie Qt Quick by mal pre nas vel’ky vyznam ked’ze ndm umoziuje navrhnit’
UI pre TrollEdit podl'a nasej potreby, ktory by bol zaujimavejsi ako sticasné GUI rieSenia

editorov. To ndm dava moznost’ v tomto smere vytvorit’ kvalitnejsi produkt.

Priklad dizajnu navrhnutého s pouzitim technoldgie Qt Quick je mozno vidiet' v takych

aplikaciach ako Skype, VLC Media Player atd’.

2.3.3 Jazyk Lua

Lua je rychly procedurdlny skriptovaci jazyk, urCeny hlavne na vnorené pouzivanie.
Programatorské rozhranie (API) je navrhnuté tak, aby umoznovalo integraciu s programami

napisanymi v inych jazykoch (C, C++, Java, C#, . . . ) vratane skriptovacich (Perl, Ruby).

Filozofiou jazyka Lua je jednoduchost’ a rozsiritelnost. Obsahuje zdkladnu funkcionalitu a
mechanizmy ako definovat’ ¢okol'vek, ¢o povazujeme za potrebné. Tymto sposobom je mozné
ziskat’" aj schopnosti objektovo orientovanych (rozhrania, dedenie) alebo funkcionalnych
jazykov. Lua je dynamicky typovand a obsahuje niekolko atomickych datovych typov
doplnenych o jednu datovu Strukturu — tabul’ku. Tabulka funguje ako asociativne pole a jej
pomocou je mozné simulovat’ iné¢ Struktury (pole, mnozina, hash tabulka, strom, atd’.) a tiez

objekty v zmysle OO paradigmy.
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Lua patri medzi najrychlejsie skriptovacie jazyky. Je implementovand v Standardnom ANSI
(ISO) C, ¢o sa prejavuje na jej vysokej prenositelnosti. Funguje pod vSetkymi znamymi
platformami. Vyhodou Lua je jej velkost' (aktudlna verzia Lua 5.1.4 m& 860KB aj s

dokumentéciou), vd’aka ktorej nie je problém pripojit’ ju cela k aplikacii, ktora ju pouziva.

Lua je vyvijana pod vol'nou licenciou (MIT) a m6ze byt pouzivand zdarma na akékol'vek (aj
komeréné) ucely. Lua sa dnes Casto pouziva pri skriptovani pocitacovych hier, ale vyuzivaja

ju aj iné programy ako napriklad Skype, Wireshark, VLC media player atd’.

2.3.4 KniZnica LPeg

LPeg je kniZnica jazyka Lua ur¢ena na hl'adanie vzoriek v texte (pattern matching). Snazi sa
odstranit’ problémy spojené s pouzivanim regularnych vyrazov, ktoré moézu byt pri
komplikovanejSich ulohach neprehladné. Je postavena na gramatikach typu PEG (Parsing
Expression Grammar) a formalizme podobnom bezkontextovym gramatikdm. Na rozdiel od
beznych gramatik, PEG nedefinuje jazyk, ale algoritmus na jeho rozpoznanie. LPeg poskytuje
dva moduly s rozlicnym spdsobom prace. V prvom module re (skratka z regex) su vzory
popisované retazcami so syntaxou odvodenou z regularnych vyrazov. Druhy modul Ipeg
pracuje so vzormi ako s premennymi vlastného datového typu a obsahuje viac spdsobov na
ich vytvaranie a spajanie. Obidva moduly podporuji vyhladdvanie (vyjadrené priamo
vzorom) rovnako ako zachytavanie retazcov na pokrocilej urovni. Vybrany text je mozné
ukladat’ do tabuliek, l'ubovolne zamienat a inak transformovat. LPeg pouziva tzv. limitovany

backtracking, vd’aka ktorému je vel'mi rychly a efektivny.

2.4 Analyza spracovavania syntaktického stromu

Na $pecifikaciu gramatiky v jazyku Lua je vyuzita kniznica LPeg. Je vytvorena gramatika pre
jazyk C, pricom vychadza zo zapisu v Bakchus-Naurovej forme (BNF). Gramatika sa
nachadza v skripte a je dynamicky kompilovand za behu aplikéacie. Spolupracu s jadrom
systému zabezpecuje C API (Standardnd sucast’ jazyka Lua) a funguje na baze zasobnika, z

ktorého Citaju a zapisuju obe strany. Komunikécia prebieha nasledovne:

e aplikacia spusti skript s gramatikou a gramatika sa skompiluje

e aplikacia zavold LPeg funkciu match, ktorej vstupom je gramatika a text (kod), ktory
chceme analyzovat’

e vystupom je Lua tabulka obsahujuca dalSie tabulky a tento systém tabuliek

zodpoveda syntaktickému stromu
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e vystup je umiestneny na zasobnik, z ktorého je postupne ¢itany

e 7 Lua tabuliek sa zrekonStruuje AST strom v C++

Gramatika vyuziva funkcie na zachytivanie Casti vstupu, ktoré zodpovedaji danym LPeg
vyrazom (podobnym regularnym vyrazom). Ku kazdej zachytenej (lexikalnej) jednotke alebo
skupine jednotieck je pripojeny identifikacny klu¢ (napr. storage class specifier,
number constant, parameter list), ktory v AST sluzi na identifikdciu uzlov. Zachytené su
vSetky znaky, teda aj tie, ktoré nie st priamo lexémami, ako napriklad biele znaky (kl'u¢
whitechar) alebo text, ktory nezodpoveda gramatike jazyka (oznaceny kli¢om unknown).
Gramatika dosial nie je Gplne kompletna, neobsahuje podporu instrukcii preprocesora v tele

funkcii a vyzaduje si d’alSie testovanie.

2.4.1 Gramatiky

Gramatiky jazykov su pisané v jazyku Lua a nachadzaji sa v prie¢inku /grammars. Pre
fungovanie programu je nutnd existencia zdkladnej gramatiky default grammar.lua. Této
gramatika slizi na rozlozenie l'ubovolného textu na slova a riadky a obsahuje funkcie
pouzivané na testovanie gramatik. V stbore s touto gramatikou st tiez popisané povinné
konStanty, ktoré musi kazdy subor s gramatikou obsahovat ako napriklad pripony
spracuvanych suborov, zoznam parovych znakov a podobne. Pomocou kniznice LPeg vytvara
Lua interpret tabulkovl reprezentaciu stromu ako systému hierarchicky vnorenych tabuliek

bez explicitnych klI'icov v tvare:
uzoll; uzoll:1; uzoll:1:1; :::; :: 3 uzoll:2;:::;uzoll:3; :: ot i

Néazov uzla je vzdy nasledovany tabulkami zodpovedajicim jeho priamym potomkom.
Zaroven by kazda gramatika mala vratit’ len jednu tabul'ku, ktord ale nemusi nutne obsahovat’
len jeden koren (napr. a; b je korektny vystup). Tabul'kova Struktara je definovana priamo v
syntaktickych pravidlach gramatiky pomocou $tandardnych LPeg funkcii lpeg.C, lpeg.Ct a
Ipeg.Cc. Vo vSeobecnosti sa predpokladd, ze subor s gramatikou obsahuje jednu kompletnu
gramatiku (full grammar) a 'ubovol'ny pocet Ciastkovych gramatik (other grammars). Plna
gramatika sa vyuziva pri analyze celého suboru a ostatné gramatiky pri analyze menSich Casti.
Napriklad, pre jazyk C sa pouZivaji gramatiky program (analyzuje cely program v C),
top_element (analyzuje funkcie, mimo-funkéné deklaracie alebo direktivy preprocesora) a
in_block (analyzuje obsah bloku prikazov). Zmysel Ciastkovych gramatik je v tom, Ze
napriklad na vyhodnotenie syntaktickej spravnosti skupiny prikazov nemdzeme pouzit

kompletnti gramatiku, pretoze skupina prikazov nie je platnym programom.
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2.4.2 Rozhranie Lua - Qt

Celu komunikiciu medzi Lua a Qt/C++ zapuzdruje trieda Analyzer. Pri poziadavke na
analyzu textu je vytvorend instancia Lua interpretu a vykonany prislusny skript. Dany text je

potom spracovany pomocou funkcie Ipeg.match a vysledok je nacitany z Lua zésobnika.

Tabulkova hierarchia je paralelne prevadzana do stromovej Struktiry reprezentovanej triedou
TreeElement. Pomocni funkciu mé trieda LanguageManager, ktord uchovava zoznam

objektov triedy Analyzer pre vSetky podporované jazyky.

Funkcie, ktoré sa staraju o analyzu kédu:

e Tato funkcia analyzuje cely kéd

// analyze string, creates AST and returns root

TreeElement* Analyzer::analyzeFull (QString input)

e Funkcia analyzuje konkrétny podstrom AST, bez nutnosti prepisovat’ celu Struktiru

// reanalyze text from element and it's descendants, updates AST and
returns first modified node

TreeElement *Analyzer::analyzeElement (TreeElement* element)

e Analyzuje sa kod pomocou vybranej gramatiky, vyuziva pritom funkciu na prepis
LUA tabuliek do AST

// analyze string by provided grammar

TreeElement *Analyzer::analyzeString(QString grammar, QString input)

e Tato funkcia konvertuje tabulky zjazyka LUA do stromovej Struktiry typu

TreeElement
// creates AST from recursive lua tables (from stack), returns root(s)

TreeElement *Analyzer::createTreeFromLuaStack ()

Trieda TreeElement obsahuje smernik na predchodcu a svojich potomkov, takto vytvara

stromovu Strukturu.
class TreeElement

{

protected: TreeElement *parent;
private:
QList<TreeElement*> children;
QString type;
Block *myBlock;
TreeElement *pair;
bool lineBreaking;
bool selectable;
bool paragraphsAllowed;
bool paired;
bool floating;

55
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3 Specifikacia poziadaviek

KedZze vychddzame z uz existujuiceho multiplatformového textového editora TrollEdit

obohatené¢ho o grafické prvky, popisujeme iba tie poziadavky na systém, ktoré chceme

implementovat pripadne modifikovat’ v sucasnej verzii.

Hlavné ciele tohto projektu su:

3.1

Rozsirit’ su¢asntl - implementovanu funkcionalitu

Modifikovat’ pouzivatel'ské rozhranie - GUI

Vytvorit’ kvalitny produkt, ktory bude tspesny a mohol by sa presadit’ aj v praxi

Funkcionalne poziadavky

Pre TrollEdit boli identifikovane funkcionalne poziadavky na zadklade dokladnej analyzy

predchédzajuceho rieSenia a taktiez na zéklade podnetov od nasho veduceho timu, ktoré su

spisané v Tab. 2.

Tab. 2 Funkcionalne poziadavky

ID PoZiadavka Charakteristika Priorita | Kategéria | UC | Diag.
Moznost vratit’ ar
FO1 | Moznost Undo/Redo | O nost vratit zmeny naspa 280 A |ucol | sp22
a opacne
Moznost’ tit’ funkci
FO2 Podpora skratiek r;)Z?;;uSP (:lrsn(l)collll cie 260 A UC15
v editore (Shortcuts) P , 8 , P .
klavesovych skratiek
Dopytovanie sa do
FO03 250 A -
Lua
Syntakticky strom by mal
. bezat’ na pozadi pod vlastnym
F04 | Podpora paralelizmu , 245 A -
vldknom a program pod
vlastnym
Prvy by bol klasicky editor na
, L. upravu kodu a po prepnuti by
2 mod
FO5 | = mody pisania editor presiel do druhého 222 A ucl4
grafického maodu.
. Moznost’ rozsirenych nastaveni
F06 | Nastavenie programu . . 206 A UC18
priamo v editore
Rozpoznévania beznych
klacovych slov
ch iazvk le ai
FO7 | Podpora intellisense | P oo o aoich JAZYROV, &1 ] 189 B -
najcastejSie pouzivané bloky
kédu (napr. funkcie, cykly,
podmienky)
F08 | Rozsirenie Moznost’ rozsirovat 130 B -

14 | Strana




Textovy editor obohateny o grafické prvky
Technicka dokumentacia

funkcionality funkcionalitu pomocou

zasuvnych modulov

F09

Vyhl'adavanie

Urcity druh fulltextového
vyhl'adavania s pripadnou
optimalizaciou pre najcastejSie
vyhladavané vyrazy

90 C UcCle

F10

Export suborov

Moznost’ exportovania suboru
do inych formatov (.csv, .doc)

40 C UCl17

F11

Schopnost’ detegovat’ urcité
ukazovatele v zdrojovom kdde
ako index udrzatelnosti,
Podpora SW metrik | cyklomaticka zlozitost’, CK 20 C UC19
metriky, ktoré by boli
zobrazen¢ v tabul’ke, pripadne
vizualne v podobe grafov

Legenda:
A — nevyhnutia funkcia systému, je zakladom funkcionality systému.

B — funkcia, ktori mozno implementovat neskor netvori zaklad funkcionality systému.
C — funkcionalita bude implementovana v dalsich verziach(release) programu

3.2 Nefunkcionalne poziadavky

Pre TrollEdit boli identifikovane nasledujuce nefunkciondlne poziadavky pre spravne

zabezpecenie fungovania programu.

Tab. 3 Nefunkcionalne poziadavky

ID Poziadavka Charakteristika
Zrychlenie programu hlavne ¢o sa tyka parsovania kodu.
NO1 | Rychlost’ a spolahlivost’ Program by mal byt schopny pracovat’ aj na menej vykonnom
hardvéri
Moznost' rozSirovania jeho funkcii pomocou dodatoc¢nej
NO02 | Modulérnost 1mple’:mentac1e n?vych moduloy. Tym pador’n nie je v zasade?
nutné zasahovat do samotnej implementacie systému pri
rozsirovani jeho funkcionality
Redesign pouivatel'ského MuS} byt JeanQuche, a p'rehl ad’ne, pri¢om ?ajpastej Sie fuvnk’me
NO03 . systému by mali byt pristupné pouzivatelovi bez naro¢ného
rozhrania GUI \ .
hl'adania
NO4 Internacionalizécia i18n | Prisposobenie programu réznym jazykovym kultiram
vratene konvencii ako pisanie ¢iarok, bodiek, daitumov
NOS Lokalizacia L10n Pouzivatel'ské rozhranie musi byt v dvoch jazykovych
mutaciach Slovensky, Anglicky
3.3 Analyza poziadaviek pre paralelizmus

Hlavnou myslienkou paralelného spracovavania bolo vyuzitie zdrojov a vykonu zariadeni na

ktorych by mal editor bezat. V dnesnej dobe uz vicsina vypoctovych zariadeni vie pracovat’
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a poskytuje na pracu minimalne dve samostatné procesorové jadrd. Aj myslienkou nasho
editora a jednou zjeho hlavnych vyhod by mala byt jeho rychlost’ a pokrocilé moznosti
vizualizécie textu aby sa mohol pacit’ pouzivatel'ovi a teda by mal bez vicSiecho meSkania
fungovat’ a reagovat’ na vstup pouzivatela. Toto sa bohuzial nedd dosiahnut’ pouzitim len
jedného hlavného vlakna, ktoré by malo na starosti vSetky tlohy. Prave preto sme rozhodli

zaviest’ do editora paralelizmus.

Tymto by sa vyrieSila otdzka efektivnosti prace editora ateda aj problém rychlosti prace
a vykonnosti editora pri spracovavani naro¢nejSich operacii. Pri povodnom rieSeni editora bol
problém z rychlostou behu niektorych operacii akymi je napriklad syntaktickd analyza.
Analyza aktualneho textu chvilu trva a pri vacSich textoch nastava problém s dlhou dobou
odozvy a zobrazenia analyzovanych prvkov, kedy pouzivatel zaziva znatné omeskanie

vizualizacie blokov.

Spominany proces syntaktickej analyzy aktualneho suboru je celkovo zdihavy najmai
z dovodu pomalej copy fazy AST stromu na stranu Qt zo strany Lua, kde prebieha analyza.
Toto je uz z Casti spojené z pdvodnym rieSenim tvorby stromu, ktory by sa mal zostavovat’ uz
na strane Lua jazyka, no ni¢ to nemeni na skutoc¢nosti, Ze analyza aktudlneho siboru by mala

byt’ schovana a bezat’ na pozadi aplikacie, kedy ni¢im nerusi pouzivatela.

Aby bolo vyuzitie paralelizmu ¢o najefektivnejSie, planuje sa najmé jeho spolupraca zo

skriptovacim jazykom Lua a teda pIné vyuzitie ich vyhod.
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4 Navrh riesenia

V tejto kapitole je popisany navrh programu TrollEdit podla poziadaviek definovanych v
predchadzajucej kapitole. Funkcionalne poziadavky sa premietnu do diagramu pripadov

pouzitia a nefunkcionalne do architektury systému.

4.1 Diagram pripadov pouzitia
Na diagrame su znazornené pripady pouzitia popisujuce funkcionalitu, ktord je uz
implementovana v programe TrollEdit a taktieZ novu funkcionalitu, ktord sme identifikovali

na zéklade analyzy. Nové pripady pouzitia s odlisené od tych existujucich ¢ervenou farbou.

UC diagram pre TrollEdit

modov pisania

* shortcuts

UCO5 Pouzitie

[ontoy

uc12 i
Pramiestiiovanie wlaelidey

-

~ .. _dincluday
¥ e

blokov textu =-=-_. JUCD7 Narabarie \\ ucoa T~
S s blokmi textu Pouzivatef Formatovanie
A2 \\- textu ™ sejncludan
ainghitiey =l
S cBxtendy - Ucoe

UC11 Skjvanie L o vyraznenle texiu
blokov G uco1 i
enerovanie
L S - 14E08 Definovanie blok dokumentdcie z
N CUZ Nastavenie
’ C extension points a fuzpozndvanic
EP_1: blok i
s Sy
fblek musf ot cefincian) il dBI——""" includiey re dokumentaciu

V‘\ \'\_____,/
UCO08 Spajanie
blokov

Extension point:
EF_1: blok

UC10 Spajania

riadkov do bloku

Obr. 2 Diagram pripadov pouzitia
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Tab. 4 Pripad pouzitia UC13 Undo/redo

ID UC13

Opis Moznost’ vol'by undo/ redo nad vykonanymi zmenami Priorita vysoka
v zdrojovom kode

Vstupne podmienky Historia vykonanych zmien

Vystupne podmienky -
Participant Pouzivatel’ (pouz.)
Zikladna postupnost® Krok Rola Cinnost’
1. Pouz.  vyberie moznost undo/ redo v pop menu na zdrojovym
kédom
2. Systém  urobi zmeny v kdde podla histérie vykonnych akcii
Alternativna Krok Rola Cinnost’
postupnost’
Poznamky -

Tab. 5 Pripad pouzitia UC14 Prepinanie médov pisania

Nazov Prepinanie médov pisania

ID UCl14
Opis Prvy mod pre klasicky editor na tipravu kodu a po prepnuti ~ Priorita vysoka
by editor presiel do druhého grafického modu
Vstupne podmienky -
Vystupne podmienky -
Participant pouzivatel’ (pouz.)
Zakladna postupnost® Krok Rola Cinnost’
1. Pouz. V pop menu si zvoli moznost’ prepnutia do druhého modu
pisania kodu
2. Systém prepne upravu kodu do grafického modu
3. Systém  rozsiri moznosti funkcionality pre graficky mod Gpravy kodu
Alternativna Krok Rola Cinnost’
postupnost’
Poznamky -

Tab. 6 Pripad pouzitia UC14 Pouzitie shortcuts

Nazov Pouzitie shortcuts

ID UCIS

Opis Priorita vysoka
Vstupne podmienky -

Vystupne podmienky -

Participant pouzivatel’ (pouz.)

Zakladna postupnost® Krok Rola  Cinnost
1.
2.
3.

18 | Strana



Textovy editor obohateny o grafické prvky
Technicka dokumentacia

Alternativna Krok Rola  Cinnost
postupnost’

Poznamky -

Tab. 7 Pripad pouzitia UC16 Vyhl'adavanie v kode

VyhPadévanie v kéde

ID ucCleé
Opis Vyhladanie zvoleného vyrazu v zdrojovom kode Priorita stredna
Vstupne podmienky -
Vystupne podmienky = Zobrazenie vysledku hl'adaného vyrazu
Participant Pouzivatel’ (pouz.)
Zikladna postupnost Krok Rola Cinnost’
1. Pouz. zada hladny vyraz do textboxu pre vyhl'adavanie a potvrdi
tlacidlom hl'adat
2. Systém  vyhlada zvoleny vyraz v aktudlnom zdrojovom kode
3. Systém = zobrazi vysledky hl'adaného vyrazu
Alternativna Krok Rola Cinnost’
postupnost’
3.a Systém v pripade nendjdenia hl'adaného vyrazu zobrazi modalne
okno s upozornenim
Poznamky -

Tab. 8 Pripad pouzitia UC17 Export siborov

ID ucC17

Opis Export stiborov zdrojového kodu do inych formatov Priorita nizka
Vstupne podmienky Parsovany zdrojovy kod

Vystupne podmienky = Vyexportovany subor

Participant Pouzivatel’ (pouz.)
Zakladna postupnost’ Krok Rola Cinnost’
1. Pouz.  vyberie moznost’ exportu stiborov zo zdrojového kodu
2. Systém ponukne moznosti do akych formatov ma exportovat’ subory
3. Pouz.  vyberie format siboru pre ulozenie
4. Systém  ulozi subory vo zvolenom formate
Alternativna Krok Rola Cinnost’
postupnost’
Poznamky format pdf, doc.
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Tab. 9 Pripad pouzitia UC18 Nastavenie programu

Nazov Nastavenie programu

ID UC18
Opis Podrobne nastavenie moznosti programu Priorita stredna
Vstupne podmienky -
Vystupne podmienky Zmena nastavenia programu
Participant Pouzivatel’ (pouz.)
Zakladna postupnost’ Krok Rola Cinnost’
1. Pouz.  sizvoli moznost’ nastavenia programu z hlavného menu
2. Systém zobrazi modéalne okno s moznost'ami nastavenia programu
3. Pouz.  vykona zmeny v nastaveniach a ulozi zmeny
4. Systém ulozi vykonane zmeny a restartuje program
Alternativna Krok Rola Cinnost’
postupnost’
4.a Systém v pripade nekorektného nastavenia ozndmi pouzivatela
varovanim oknom s popisom chyby
Poznamky -

Tab. 10 Pripad pouzitia UC19 Zobrazenie sw metrik

Nazov Zobrazenie sw metrik

ID UcC19

Opis Zobrazenie sw metrik zdrojového kodu Priorita nizka
Vstupne podmienky Zdrojovy kdd pre vygenerovanie metrik

Vystupne podmienky Zobrazenie vysledkov metrik vo forme grafov

Participant Pouzivatel’ (pouz.)
Zikladna postupnost® Krok Rola Cinnost’
1. Pouz. si zvoli moznost’ zobrazit’ sw metriky z menu
2. Systém = vygeneruje metriky zo zdrojového kodu a zobrazi vysledky
0 forme grafov
Alternativna Krok Rola Cinnost’
postupnost’
Poznamky -

4.2 Architektira programu

Architektiru programu by sme chceli postavit na klasickom trojvrstvom principe, t.].

rozdelena na prezentacnu, biznis a datovl vrstvu vid. Obr. 3.

V prezentacnej vrstve budi implementované triedy pre grafické rozhranie editora od hlavného
menu az po napovedu. Prezentana vrstva bude komunikovat’ s biznis vrstvou, v ktorej bude

spracovavana aplikacna logika programu.

Biznis vrstva sa bude skladat' z troch komponentov. Jeden pre jadro systému kde bude

implementovana zakladnd funkcionalita programu. Druhy pre parsovanie zdrojového kodu,
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kde sa bude vytvarat AST strom v skriptovacom jazyku Lua. A treti pre priddvanie novej

funkcionality, ktora nenarusi zakladnu funkcionalitu jadra programu.

V datovej vrstve budl data ktoré si bude program ukladat’ ako nastavenie programu docasnu

historiu zmien nad zdrojovym kodom a tidaje o projekte.

Prazznentaéna vrstva |

o GLIn
Grafické rozhranie editora

Biznis vrsiva |
suser wComponets
ottt T Jadro systému
i
\/ =
«Componet o :
Farsovanie kédu Lua ! wuser
'
:
'
]
w Componie
Zasuvne moduly

Y

Datova vrstva |

‘ «Componels

Konfiguraéne moduly

Obr. 3 Architektura programu

4.3 Navrh Ul

Na zéklade analyzy sme identifikovali 5 pouz. okien, ktoré budu v programe implementované.
Tieto oknd budt mat’ hierarchicky vyznam, t.j. okno na vyssej irovni mdze volat’ iba okné na

nizsej urovni, nie vsak opacne.

Trolledit

Textovy editor obohateny o graficks pruky

SplashScreen

<<Call>>

Hlavné menu
<<main.gui>>

<<Call>> <<Call>>

<<Call>>

Nastavenie editora Napoveda
<<set.gui>> <<help.gui>>

Informécie o programe
<<info.gui>>

Obr. 4 Hierarchické rozdelenie okien programu
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Tab. 11 Popis obrazoviek programu

ID Nazov Popis Modalne/ | Rozmery | Obr.
nemodalne
WO1 | SplashScreen uvodny okno, ktoré sa zobrazi vzdy pri spusteni, M 420x201 5

odstranuje problémy studeného Startu

W02 | Hlavne menu okno, ktory obsahuje hlavnt funkcionalitu

. N 544x184 6
systému
W03 | Nastavenie okno, ktoré sluzi pre detailné nastavenie editora M 1256x768 7
W04 | Info okno, ktoré zobrazuje informéacie o programe ako
popis programu, datum vytvorenia, verzia M 1256x768 8
programu.
W07 | Napoveda okno pre zobrazenie napovedi programu N 900x650 9

TroIIEdlt

textavi editor obohaterf o

Obr. 5 SplashScreen programu

]r mit Zobrazenie Népoveda

Tr‘o Edit

textovy editor obohatenf o grafické prky

e £ & »He™

Obr. 6 Predbezny navrh hlavného menu programu

22 | Strana



Textovy editor obohateny o grafické prvky
Technicka dokumentacia

4.4 Navrh funkcionality UNDO/REDO

4.4.1 QtUndo Framework

Koncepcia

Je to implementacia navrhového vzoru Command. Zakladnou myslienkou tohto vzoru je, Ze
kazda zmena v aplikécii je vykonavand pomocou vytvérania ,,Command“ objektov. Tieto
objekty aplikuji zmeny a su ulozené do ,,Command stack“-u. Vdaka tomu kazdy Command
objekt vie ako vratit predchadzajaci stav dokumentu. Pomocou prechadzania stacku

a zavolania funkcii undo() a redo() vieme vykonavat’ akcie UNDO/REDO.

Navrh rieSenia
Do triedy MainWindow by sme vytvorili QUndoStack pre uchovavanie Command objektov a

QUndoView na sledovanie a interakciu so stackom.

QUndoStack *undoStack;
QUndoView *undoView;

Pomocou funkcie createUndoView() vytvorime QUndoView

volid MainWindow: :createUndoView ()
{
undoView = new QUndoView (undoStack) ;
undoView—->setWindowTitle (tr ("Command List")) ;
undoView->show () ;
undoView->setAttribute (Qt::WA QuitOnClose, false);

Vo funkcii createActions() vytvorime akcie UNDO/REDQO

void MainWindow: :createActions ()
{
undoAction = undoStack->createUndoAction (this, tr("&Undo"));
undoAction->setShortcuts (QKeySequence: :Undo) ;
redoAction = undoStack->createRedoAction(this, tr("&Redo"));
redoAction->setShortcuts (QKeySequence: :Redo) ;

Vytvorime “Command’ na zmazanie.

class DeleteCommand: public QUndoCommand
{
public:
DeleteCommand (QGraphicsScene *graphicsScene, QUndoCommand *parent = 0);
void undo () ;
void redo() ;
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private:
QGraphicsScene *myGraphicsScene;
35

Implementujeme funkcie undo() a redo()

void DeleteCommand: :undo ()
{ myGraphicsScene->addItem (myDiagramItem) ;
myGraphicsScene->update () ; }

volid DeleteCommand: :redo ()
{ myGraphicsScene->removeltem (myDiagramItem); }

Vyhoda: rychla, prehl'adna a skalovatel'na implementacia funkcionality UNDO/REDO

Nevyhoda: vytvaranie ,,Command* objektov pre kazdu akciu moze byt neefektivne. potreba

zmeny existujiicej implementécie.

4.4.2 QScintilla

Ulozi akcie vykonavané na dokumente. Umoziiuje kombinaciu viacerych akcii do transakcii,

na ktorymi je potom mozZné vykonat’t UNDO/REDO.

Obsahuje rozne priznaky, ktoré uruju ¢€i je mozné alebo nie je mozné vykonat

UNDO/REDO.

Vyhoda: poskytuje moznost riadenia zmien na dokumentoch pomocou zakladnych

operacii UNDO/REDO.

QScintilla poskytuje aj d’alSie operacie vhodné pre pracu so zdrojovymi subormi.

(Syntax highlighting, Searching,Replacing, Key bindings, Copy, Paste)
Nevyhoda: prestudovanie novej technologie a neprehl'adna implementacia

4.4.3 QTextDocument

QTextDocument je graficky element, ktory obsahuje formatovany text.

Poskytuje sloty a funkcie na podporu funkcionality UNDO/REDO.

void redo ()
void setModified ( bool m = true )
void undo ()
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Atribut modified poskytuje informéciu o tom ¢i bol alebo nebol dokument modifikovany.

Okrem toho obsahuje funkcie aj na zistenie dostupnosti operacii UNDO/REDO.
Vyhoda: nepotrebujeme nové technologie, maly zasah do existujuceho kodu

Nevyhoda: poskytuje len trivialne rieSenie

4.5 Navrh funkcionality pre shortcuts

Spoloénym pouzitim object model a action system v Qt mdZeme vytvorit’ prisposobitel'né
funkcie v editore akcii, ktoré sa daji integrovat’ do uz existujucich aplikacii. Qt action system
je zalozeny na triede QAction, ktora uchovava informéacie o vSetkych réznych sposoboch ako

je mozné spustit’ urcity prikaz v aplikacii.

4.5.1 Dialogové okno
Vytvorime si dialogové okno, ktoré umozni pouzivatel'ovi prispdsobovat’ klavesové skratky
v aplikacii. V jednom stipci buda vypisané akcie a v druhom stipci budt vypisané klavesové

skratky, ktoré bude mdct’ pouzivatel’ editovat’.

Definicia triedy ActionsDialog:

class ActionsDialog : public QDialog

{
Q OBJECT
public:
ActionsDialog (QObjectList *actions,
QWidget *parent = 0);
protected slots:
void accept () ;

private slots:
volid recordAction (int row, int column) ;
vold validateAction (int row, int column) ;

private:
QString oldAccelText;
QTable *actionsTable;
QValueList<QAction*> actionsList;

}s
Ked sa text klavesovej skratky edituje, tak sa vyuziju funkcie recordAction() a

validateAction(). Funkcia accept() sa vyuzije, ked’ dialégové okno akceptuje skratku.

Konstruktor plni tlohu vytvorenia pouzivatel'ského rozhrania . Na minimalizovanie vplyvu na

aplikaciu sa trieda vytvori v QObjectList a pouzijeme QTable na zobrazenie informacii.
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ActionsDialog: :ActionsDialog (QO0bjectList *actions,
QWidget *parent)
QDialog (parent)

actionsTable = new QTable (actions->count (), 2, this);
actionsTable->horizontalHeader () ->setLabel (0,
tr ("Description")) ;

actionsTable->horizontalHeader () ->setLabel (1,
tr ("Shortcut")) ;
actionsTable->verticalHeader () ->hide () ;
actionsTable->setLeftMargin (0) ;
actionsTable->setColumnReadOnly (0, true);

V tabulke je povolené editovat’ len jeden stipec a odstranime z nej aj vertikalnu hlavicku na

lavej strane.

Kazda akcia je taktiez pridand do zoznamu, ktory ndm umozni vyhl'adat’ akciu zodpovedajicu

danému riadku v tabul’ke. Toto eSte budeme pouzivat’ na modifikovanie akcii.

QAction *action =
static cast<QAction *>(actions->first());
int row = 0;

while (action) {
actionsTable->setText (row, 0, action->text());
actionsTable->setText (row, 1,
QString(action->accel()));
actionsList.append (action) ;
action = static_cast<QAction *>(actions->next());
++row;

}
e Dial6égové okno bude mat’ dve tlacidla: OK a Cancel

QPushButton *okButton = new QPushButton (tr ("&OK"), this);

QPushButton *cancelButton = new QPushButton (tr ("&Cancel"), this);
connect (okButton, SIGNAL (clicked()),
this, SLOT (accept())):
connect (cancelButton, SIGNAL(clicked()),
this, SLOT (reject())):

e Dva signdly z tabul’ky sluZzia na editaény proces

connect (actionsTable, SIGNAL (currentChanged(int, int)),
this, SLOT (recordAction (int, int)));
connect (actionsTable, SIGNAL (valueChanged(int, int)),
this, SLOT(validateAction (int, int))):;

setCaption(tr ("Edit Actions"));
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4.5.2 Proces editovania
Ked pouzivatel’ za¢ne upravovat’ bunku, actionsTable vysle signal currentChanged() a zavola
sa recordAction() s riadkom a stipcom bunky.

void ActionsDialog::recordAction (int row, int col)

{

oldAccelText = actionsTable->item(row, col)->text();

Predtym, nez pouzivatel' dostane Sancu modifikovat’ obsah, uloZime si aktudlny text bunky.

Ked’ nebude vyhovovat’ zmeneny text, tak sa text bunky vrati na pdvodny.

void ActionsDialog::validateAction(int row, int column)
{
QTableItem *item = actionsTable->item(row, column) ;
QString accelText = QString (QKeySequence (
item->text ()));

if (accelText.isEmpty () && !item->text().isEmpty()) {
item->setText (0ldAccelText) ;
} else {

item->setText (accelText) ;

b}

Pouzijeme QKeySequence na kontrolu nového textu. Ak novy text nemoze byt pouzitelny
QKeySequence, tak sa do bunky ulozi povodny text. Ked pouzivatel' z bunky zmaze stary
text a nezada novy, tak bunka zostane prazdna. Ked’ novy text moze byt pouzitelny, tak sa

ulozi do bunky a nahradi stary text.

void ActionsDialog: :accept ()
{
for (int row = 0; row < actionsList.size(); ++row) {
QAction *action = actionsList[row];
action->setAccel (QKeySequence (
actionsTable->text (row, 1)));

}

QDialog::accept () ;

Pri stlaceni tlacidla OK sa zmeny ulozia a pri stlaCeni Cancel sa vSetky zmeny stratia.

4.5.3 Editovanie, nacitanie a ukladanie skratiek
V aplikacii musime zabezpecit’ otvorenie dialdogu s pouzivatel'ského rozhrania, nacitanie

nastavenia skratiek a ich ukladanie.

ApplicationWindow: :ApplicationWindow ()
OMainWindow (0, "example application main window",
WDestructiveClose)
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QPopupMenu *settingsMenu = new QPopupMenu (this);
menuBar () ->insertItem(tr ("&Settings"), settingsMenu) ;

QAction *editActionsAction = new QAction(this);
editActionsAction->setMenuText (tr (

"g¢Edit Actions...")):
editActionsAction->setText (tr ("Edit Actions"));
connect (editActionsAction, SIGNAL (activated()),

this, SLOT (editActions())):;
editActionsAction->addTo (settingsMenu) ;

QAction *saveActionsAction = new QAction(this);
saveActionsAction->setMenuText (tr ("&Save Actions™));
saveActionsAction->setText (tr ("Save Actions"));
connect (saveActionsAction, SIGNAL (activated()),
this, SLOT (saveActions())):
saveActionsAction->addTo (settingsMenu) ;

Na prepisanie predvolenych klavesovych skratieck vlozime nasledovny kod na koniec

konstruktorov:

loadActions () ;

Funkcia LoadActions () slizi na zmenu skratky kazdého QAction, ktorého ndzov zodpoveda

zaznamu v nastaveni:

void ApplicationWindow: :loadActions ()
{
QSettings settings;
settings.setPath("trolltech.com", "Action");
settings.beginGroup ("/Action") ;

QObjectList *actions = queryList ("QAction");
QAction *action =
static cast<QAction *>(actions->first());

while (action) {
QString accelText = settings.readEntry (
action->text ());
if (laccelText.isEmpty())
action->setAccel (QKeySequence (accelText) ) ;
action = static cast<QAction *>(actions->next());

Téato funkcia zavisi na predvolené hodnoty z QSettings:: readEntry (), aby zabezpecili, ze

kazda akcia je zmenit’ iba v pripade, ze je vhodny vstup s platnou skratku k dispozicii.
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editActions () vykonava ulohu otvorit’ dialdg so zoznamom vsetkych akcii hlavného okna:

void ApplicationWindow: :editActions ()

{

ActionsDialog actionsDialog(queryList ("QAction"),
this) ;
actionsDialog.exec () ;

QObjectList vratené QueryList () obsahuje vSetky QActions v hlavnom okne, vratane tych

novych, ktoré sme pridali do menu.

saveActions() je volané vzdy ked’ Save Action menu je aktivované:

void ApplicationWindow: :saveActions ()
{
QSettings settings;
settings.setPath("trolltech.com", "Action");

settings.beginGroup ("/Action") ;

QO0bjectList *actions = queryList ("QAction");
QAction *action =

static cast<QAction *>(actions->first());

while (action) {
QString accelText = QString(action->accel()):;
settings.writeEntry (action->text (), accelText);

action = static cast<QAction *>(actions->next());

4.6 Navrh spracovania syntaktického stromu

Ako spdsob spracovania syntaktického stromu navrhujeme dokopy tri mozné rieSenia.

C++ -> LUA C API -> LUA -> AST
Ak by bol zmeneny kod, tak sa z C++ cez LUA C API posle poziadavka na vykonanie
analyzy zmenené¢ho kdédu na strane Lua, pomocou kniznice Lpeg. Lua spristupni tabulky

reprezentujuce AST, nad ktorymi sa bude d’alej pracovat’ v C++ kode.
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Vyhody :

e Rychlejsie volanie

e Ziadna datova redundancia
Nevyhody :

e Problém pri spétnej zmena dat (grafické vykresl'ovanie)
C++ -> LUA FFI C &trukttra -> AST
Ak sa zmeni kod, tak sa poSle poziadavka na vykonanie analyzy pomocou kniznice Lpeg.
Potom sa vytvori Lua skript, v ktorom sa tabul’ky vygenerované kniznicou Lpeg transformuja
do C struktar prepojenych smernikmi pomocou FFI kniznice. Nasledne by sa do C++ kodu

poslal smernik na tieto Struktury, kde by sa s nimi d’alej pracovalo.

Vyhody :

o Ciastotné zrychlenie

e Zachovana myslienka manipulacie s AST
Nevyhody :

e Redundancia dat

C++ -> C StruktGra -> LUA FFI Lpeg (AST)

Lpeg kniznicu prepiSeme pomocou FFI kniznice tak, ze nebude reprezentovat’ AST pomocou
Lua tabuliek, ale priamo bude vytvarat AST v C Struktare. Nasledne posle smernik na tato
Struktiru do C++ kodu, kde sa stiou bude dalej pracovat. Tymto by malo byt mozné
dosiahnut’ niekol'’konasobné zrychlenie, nakol’ko praca s C Struktrou je ovela rychlejsia. To

je sposobené najmé dynamickym ur¢ovanim datového typu Lua tabulky.

Vyhody :

e Vel'mi velké zrychlenie

e Zachovana myslienka manipulacie s AST
Nevyhody :

e Naro¢nd implementécia
Rozhodli sme sa pre prva variantu, a teda dopytovanie sa na AST cez LUA C API. Druhtu
variantu sme zamietli kvoli redundancii dat, a teda by nemusela poskytovat’ zelané zrychlenie
programu. Tretiu variantu sme zamietli kvoli narocnosti implementécie, ale v pripade potreby

¢o najvicsej optimalizacie vykonu aplikédcie budeme nad touto variantou znova uvazovat’.

Navrh spracovania AST pomocou prvej varianty bude teda vyZadovat’ nasledovné upravy.

Funkcia TreeElement *Analyzer::createTreeFromLuaStack() by sa zrusila a jej funkcionalita
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by bola nahradend Ciastkovymi volaniami z tabul'ky na strane jazyka LUA. Tieto Ciastkové
volania by musela implementovat’ nova trieda, ktora by plne nahradila triedu TreeElement.
Takato zmena reprezentacie AST by znamenala zna¢nli zmenu architektiry celej aplikacie,
lebo ostatné triedy s striedou TreeElement silno previazané. V C++ by sme uz viac
nevytvarali AST, len by sme sa dopytovali na strane LUA, kde by bol trvalo pristupny a menil

sa len pri jeho modifikacii.

4.6.1 Experimentovanie s LUA C API/FFI library

Nativny sposob mapovania C funkcie do LUA skriptu
Tato funkcia sluzi na registrovanie C funkcie pre LUA skript
void lua register (lua State *IL,

const char *name,
lua CFunction f);

Priklad pouzitia:

Definicia funkcie, ktorta volame v LUA skripte

static int average (lua State *L)

{

int n = lua gettop(L); /* get number of arguments */
double sum = 0;
for (int 1 = 1; i <= n; 1i++) /* loop through each argument */
{

if (!lua isnumber (L, 1i))

{
lua pushstring(L, "Incorrect argument to 'average'");
lua_error (L) ;

}

sum += lua tonumber (L, i); /* total the arguments */
}
lua pushnumber (L, sum / n); /* push the average */
lua pushnumber (L, sum); /* push the sum */
return 2; /* return the number of results */

}

Ukézka registracie funkcie pre LUA skript

L = lual newstate(); /* initialize Lua */

lual openlibs (L) ; /* load Lua base libraries */
lua register (L, "average", average); /* register our function */
lual dofile (L, "C:\\TEST\\lua call.lua"); /* run the script */

lua close(L); /* clean up LUA */

Ukéazka LUA skriptu, ktory pouziva C funkciu

avg, sum = average (10, 20, 30, 40, 50)
print ("The average is ", avg)
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print ("The sum is ", sum)

Nativny spdsob mapovania LUA funkcie do C kodu
Definicia, ktorti volame v LUA skripte

function £ (x, y)
io.write ("The table the script received has:\n")
local xx =1
for i = 1, #foo do
print (i, foo[i])
xx = xx + foo[1l]
end
io.write ("Returning data back to C\n")
return x + y + xx
end

Ukazka kodu, kde voldame LUA funkciu v C kode, tiez na stranu LUA posieclame data do

tabul’ky a dva parametre pre funkciu

L = lual newstate();
lual. openlibs(L); // Load Lua libraries
int status = lual dofile(L, "C:\\TEST\\script.lua");
lua newtable (L) ; // We will pass a table
for (int i = 1; 1 <= x; 1++) {

lua pushnumber (L, 1); // Push the table index

lua pushnumber (L, i*3); // Push the cell value

//lua_rawset (L, -3); // Stores the pair in the table

lua_ settable (L, -3);
}
lua setglobal (L, "foo");// By what name is the script going to reference
our table?
lua getglobal (L, "f");
lua pushnumber (L, 5);
lua pushnumber (L, 5);
int result = lua pcall(L , 2, 1, 0); // Ask Lua to run our little script
if (!lua_isnumber (L, -1)) //Get the returned value at the top of the stack
(index -1)
int sum = lua_ tonumber (L, -1);
lua pop(L, 1); // Take the returned value out of the stack
lua close(L);

Nativna FFI (Foreign Function Interface) kniZnica
FFI kniZnica umoziiuje volanie externych C funkcii a pouzivanie C datovych Struktir v Lua
skripte. FFI kniznica do velkej miery obmedzuje nutnost’ pouzitia nativnych Lua\C volani v C

kode. Tento sposob je jednoduchy, ked’Ze FFI parsuje deklaracie C kédu.

Ukézka jednoduchého pouzitia C funkcii v Lua skripte:

local ffi = require(“ffi”)
ffi.cdef[][
int printf (const char *fmt, ...);

int rename (const char* oldname, const char* newname) ;

int MessageBoxA (void *w, const char *txt, const char *cap, int
type) ;
11
ffi.C.printf ("Hello %s!", "world")
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ffi.C.rename ("pokus.txt", "success.txt")
ffi.C.MessageBoxA(nil, "Hello world!", "Test", 0)

Tento skript vykona nasledovné akcie. V prvom riadku nacita FFI kniznicu. Potom nasleduje
ffi.cdef blok, v ktorom st deklaracie C funkcii, ktoré chceme skriptu spristupnit’. Potom

nasleduju volania tychto funkcii s uz konkrétnymi volaniami. Vystupom tychto volani bude:

— VypiSe text “Hello world”
— Premenuje suUbor “pokus.txt“ na “success.txt” v aktudlnom adreséari

— Zobrazi okno s textom “Hello world!”, ndzvom “Test” a tlac¢itkom “OK”

4.7 Navrh rieSenia paralelizmu

Vramci navrhu rieSenia andsledného experimentovania boli preStudované moznosti
implementécie paralelizmu, ktoré ndm rovno poskytuje Qt framework. V predchadzajicich
verziach Qt moznosti paralelného spracovania neboli velmi rozsiahle, v podstate celkova
praca vychadzala z pouzitia QThread triedy. S nasadenim aktudlnej 4.4 verzie Qt frameworku
boli znac¢ne rozsirené pristupy pre paralelizmus, ktoré uz si vhodne implementované a teda je
mozné ich pouzit pre rieSenie pokrocilejSich problémov. V podstate principy a praca

s vlaknami je v Qt podobna pristupu, ktory je vyuzivany v rdmci jazyka Java.

Pre néslednu integraciu boli nastudované viaceré pristupy a triedy poskytujuce vhodné
paralelné rieSenia, priCom sme celkovo identifikovali dva mozné pristupy pre zavedenie

paralelného spracovania:

4.7.1 QRunnable pristup

Trieda QRunnable slizi ako zakladné trieda pre vSetky beziace objekty. V skuto¢nosti si ju
modzeme predstavit’ ako interface, ktory sa pouziva pre reprezentovanie ulohy alebo cCasti
kodu, ktory je potrebné vykonat. Pri tomto spOsobe su vyuzivané upravené objekty pre
potreby behu paralelného vldkna. Teda pre spustenie paralelného vldkna je nutné

implementovat’ funkciu run(), ktort poskytuje dany interface.

Oproti starSiemu rieSeniu cez dedenie triedy QThread zo sebou priniesol viaceré vyhody:
¢ QRunnable nema ziadnu zakladnu triedu
e Dbohuzial nevyuziva signdli a sloty
e ma jednoduchu konstrukciu, naopak vyuzitie QObject je velakrat tazkopadne
e bezi na akomkol'vek vol'nom vldkne a tym riesi cenu vytvarania nového vlakna

e novinka zavedena v Qt 4.4
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Pri pouziti daného interfacu hovorime o asynchréonnom pristup, pri ktorom su vsetky vldkna
pre vykonanie koédu spuastané a ulozené vramci QThreadPool Struktary. QThreadPool

manazuje a ma kontrolu nad vldknom, ktoré po skonceni automaticky zmaze.

class HelloWorldTask : public QRunnable {
void run ()
{gDebug () << "Hello world from thread" << QThread::currentThread() ;
}

}
HelloWorldTask *hello = new HelloWorldTask() ;

QThreadPool::globalInstance()->start (hello);

Je mozné ovplyvnit’ cez flag, Co sa ma po zbehnuti tlohy s vlaknom stat’.
QRunnable: :setAutoDelete () - to change the auto-deletion flag

V sucasnej dobe je to stale jeden znajpouzivanejSich spdsobov, pomocou ktorého je

implementovany paralelizmus v sucasnych aplikaciach.

4.7.2 QtConcurrent pristup

Tento pristup k paralelizmu je zalozeny na Concurrent frameworku. V podstate vznikol ako
odpoved’ na rieSenie otdzky kedy uz mame implementovanu funkciu, ale nie je nad nou
postaveny Ziaden QThread alebo QRunnable pristup? V tom pripade je QtConcurrent idealne
rieSenie. V tomto pripade ide rovnako o o asynchréonny pristup, ktorého API je ale uz

postavené na vyssej urovni synchroniza¢nych principov.

Na rozdiel od inych sposobov sa sustred’'uje priamo na spustenie funkcie v samostatnom
vlakne. V ramci tohto pristupu je vyhodou, Ze nie je nutné robit ziaden zasah do uz
existujucich funkcii a metdd. Priamo za pomoci poskytnutého frameworku vieme paralelne

spustit’ jednotlivé funkcie.

The QtConcurrent::run() cez funkciu run sa spusta funkcia v samostatnom vlakne.
QFuture<void> future = QtConcurrent::run(function name, argl, arg2, ...);

Ako je vidiet, argumenty je mozné posielat’ do funkcie v ramci run() hned za menom
spustanej funkcie. Trieda QFuture ndm tu poskytuje uzitocné funkcie ako isFinished,

isRunning, isStarted, waitForFinished, alebo result.
QString result = future.result();

Vysledky spusteného vldkna su spristupnené cez QFuture API. Trieda QFuture a d’alSia trieda

QFutureWatcher sa pouzivaji na monitorovanie stavu funkcii vo vlaknach.
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Funkcia QFuture::result() blokuje spracovanie acaka na vysledok, avSak pri pouziti
QFutureWatcher ide o neblokujucu synchronizéaciu, kedy je mozné pozadovat’ notifikovanie

az beh funkcie a teda aj vlakna skonci.

Pre nesynchronny pristup je lepSie nastavit’ pri vytvarani vlakna Signal aky bude vyslany po

skonceni vlakna a Slot, ktory registruje a spracuje tento signal.

4.7.3 Zdielanie zdrojov medzi paralelnymi vlaknami

V rdmci navrhu sme sa zamerali eSte na jednu problematiku, ktord s paralelizmom priamo
suvisi ato je zdielanie spolocnych zdrojov v pamiti. Qt frameworku na rieSenie tohto
problému poskytuje triedu QSharedMemory. Tato Struktira poskytuje prostriedky pre
vytvorenie priestoru v pamiti, ku ktorému moézu pristupovat’ vSetky vldkna, ktoré maja
pristupovy kl'u¢. Zaroven obsahuje aj zakladné synchroniza¢né prostriedky pre zabezpecenie

subezného pristupu do takejto paméite.

4.7.4 Zhodnotenie

Aj ked’ obidve metédy spiiaju poziadavky paralelizmu v editore, predsa len sme sa pre

potreby zavedenia paralelizmu rozhodli vyuzit’ druhy pristup a to z viacerych dévodov:

e aby sme sa vedeli ¢o mozno najviac priblizit' k tym skutocnym castiam a funkcidm
editora, ktoré maju byt vykonavané paralelne
— napr. samostatnd analyza na strane Lua sa spusta vramci jednej metddy
analyze, ktora je ale sucastou komplexnejsej triedy Analyzer pre celkovu pracu
s Lua
e kedze staviame na uz existujicom rieSeni, ktoré d’alej rozSirujeme a upravujeme,
vyuzitie druhého popisaného znamena fakt, Ze uz existujuce Casti nemusime

dodatocne prerabat’

e ide o pokrocilejSiu paralelnt techniku, a teda by mala byt efektivnejSia a rychlejsia

ako starSie rieSenia

e kedze ide o graficky editor, ktory pre svoju pracu vo velkom vyuziva principy signal
a slot, nemal by byt problém asynchronne spracovavat vysledok vlédkna, ktorého

signal by mal byt odchytdvany
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5 Implementacia prototypu

Tato kapitola popisuje implementaciu systému t.j. prevedenie navrhu do vysledného

funk¢éného kodu.

5.1 Implementacia 2 modov editacie

Pre potrebu implementicie dvoch modov editdcie bola vytvorend trieda TextGroup, ktora
poskytuje klasické moznosti editacie textu ako iné textové editory. Tato trieda dedi svoje
vlastnosti od triedy QGraphicsTextltem zlucuje v sebe textovy editor a schopnost’ grafického
zobrazenia v triede QGraphicScene. Pri prepnuti modu sa nahrddza miesto triedy
BlockGroup. Pri opidtovnom prepnuti modu posiela triede BlockGroup editovany obsah textu
a zanikd. V takomto minimalistickom rieSeni dosahujeme uspokojivé implementovanie
funkcionality 2 mddov, v ktorom sa zachovava konzistencia editovaného textu a pri tom aj

vyhody formatovania blokov na grafickej scéne.

TextGroup: : TextGroup (BlockGroup *block, DocumentScene *scene)
QGraphicsTextItem (0, scene)

{
this->block = block;
this->setPlainText (block->toText ()) ;
this->setPos (block->pos () .x () ,block->pos () .y ());
this->setScale (block->scale());
this->setFlags (QGraphicsItem::ItemIsSelectable|

QGraphicsItem: :ItemIsFocusable | QGraphicsItem::ItemIsMovable);
this->setTextInteractionFlags (Qt::TextEditorInteraction);
Block *temp = new Block(new TreeElement ("temp"), 0, block);
QFont *f = new QFont (temp->textItem()->font()):;
this->setFont (*f);

}

Prepnutie médu nastava stlatenim alt a l'avym tla¢idlom mysky. Nastava poslanie aktualnych

parametrov a zobrazenie bloku.

void TextGroup::mousePresskEvent (QGraphicsSceneMouseEvent *event)
{
if (event->button () == Qt::LeftButton) {
if ((event->modifiers() & Qt::AltModifier) == Qt::AltModifier)
{
block->setContent (this->toPlainText ()) ;
block->setPos (this->pos () .x (), this->pos().y());
this->setVisible (false);
block->setVisible (true) ;
scene->update () ;
event->accept () ;
}

}
QGraphicsTextItem: :mousePressEvent (event) ;
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5.2 Experimentovanie a implementacia funkcionality Undo/Redo

Ked’Ze ide o textovy editor pri implementacii funkcionality Undo/Redo sme sa zamerali na
pracu s textom. VacSina akcii vykonanych v editore pracuje priamo s textom a az potom sa
rieSi vizualizdcia jednotlivych blokov. Preto najdolezitejSie je identifikovat’ vSetky miesta,
kde sa text zmeni auchovavat stav pred apo vykonani akcie, ktora zmeni text. Pri

implementacii tejto funkcionality je mozné vyuzit’ navrhovy vzor Command.

5.2.1 Experimentovanie

Pri experimentovani sme sa hlavne zamerali na vyuzitie Qt Undo Frameworku, ktora

umoziuje implementaciu navrhového vzoru Command.

e To triedy MainWindow sme pridali zdsobnik na uloZenie jednotlivych akcii a ,,view*

na zobrazenie historie vykonanych akcit

class MainWindow : public QMainWindow {

QUndoStack *undoStack;
QUndoView *undoView;

undoStack = new QUndoStack (this);

e Potom sme vytvorili sibor commands.cpp, v ktorom sa nachddzaju implementacie

jednotlivych akcii. Pre kazda akciu sme vytvorili vlastnu triedu.
class AddTextCommand : public QUndoCommand

{
Q OBJECT
public:
AddTextCommand (QString text, TextItem* myTextItem, DocType *docType,
Arrow* arrow, QString* path);

void undo(); // implementécia akcie pre undo
void redo(); // implementacia akcie pre redo
private:

QString text;
TextItem *myTextItem;
DocType *docType;
QString *path;

}i

e Pri zavolani funkcie na pridavanie textu sa vytvori novy objekt triedy
AddTextCommand, ktory vykona akciu. Po vykonani akcie sa objekt ulozi do

zasobnika.
volid MainWindow: :addText ()

{

37|Strana



if (diagramScene->selectedItems () .isEmpty())
return;

QUndoCommand *addTextCommand = new addTextCommand (diagramScene) ;
undoStack->push (addTextCommand) ;

e Funkcionalitu Undo/Redo dosiahneme vlozenim a vyberom jednotlivych objektov zo

zasobnika a zavolanim funkcie undo () resp. redo ()

5.2.2 Samotna implementacia

Pri implementacii sa v prvom rade zameriavame na pracu s textom a az potom rieSime veci
ako su napr. dokumenta¢né bloky. Na implementdciu vyuzijeme Qt Undo Framework

a vychadzame z vysledkov, ktoré sme ziskali experimentovanim.

5.3 Experimentovanie a implementacia paralelizmu

V ramci tejto Casti sme sa zamerali na dve veci. Prvou je experimentovanie s navrhovanymi
moznymi rieSeniami tak ako to byva zvykom pri vyuzivani novych technologii. Nasleduje
popisanie rieSenia samotnej implementacie, v rdmci ktorej su rozvinuté otazky, ktoré je

vhodné riesit’.

5.3.1 Experimentovanie

¢ QRunnable implementécia a ¢itanie zo zdiel'anej paméte vo vlakne

class Work : public QRunnable
{
public:
void run() {
gDebug () << "Hello from child thread " << QThread::currentThread()
//zavolanie dal3ej funkcie na vykondvanie napr.
loadFromSharedMemory ()
}
void loadFromSharedMemory ()
{
QSharedMemory sharedMemory ("SM key");
sharedMemory.attach () ;
sharedMemory.lock() ;
char *to = (char*)sharedMemory.data();
gDebug () << to;
sharedMemory.unlock () ;
sharedMemory.detach () ;

e (QSharedMemory — inicializacia a zapisanie do zdiel'anej paméte

// QSharedMemory - inicializéacia
QSharedMemory sharedMemory ("SM key");

sharedMemory.create(1024);

// QSharedMemory — zapisanie do pamate, treba poskytntt len meno
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void writeToSM(QString &SM key)
{
QSharedMemory sharedMemory (SM key) ;
sharedMemory.attach () ;
sharedMemory.lock () ;
char *to = (char*)sharedMemory.data();
char *text = "hello world printed from SharedMemory by writeToSM
function in separate thread";
memcpy (to, text, strlen(text)+l);
sharedMemory.unlock () ;
sharedMemory.detach () ;

e Vyuzitie QtConcurrentRun

// QtConcurren::run spusti metdéddu writeToSM v novom vldkne a poSle meno
QFuture<void> future2 = QtConcurrent::run(writeToSM, (QString) "SM key");
QFutureWatcher<void> watcher2.setFuture (future2) ;

5.3.2 Samotna implementacia
V prvom rade sme sa mali v rdmci paralelizmus zamerat’ na ulahcenie syntaktickej analyzy

textu, ktord by mala bezat’ na pozadi aby nerusila pouzivatel'a a nebrzdila ho pri praci.

Na zéklade aktualneho spdsobu prace v editore, sme sa rozhodli zvlast' vytvarat’ lokalne
lua_state v novo spustenom vlakne, ktorym bude po skonceni nahradeny predchadzajici uz

neaktualny lua_state.
Pocas implementacie bude potrebné vyriesit’ nasledujiuce problémy:

e Ako preklopit novu analyzu na ti sktorou pracuje editor. Teda vymenit novy
lua_state a jeho obsah za ten pracovny, s ktorym sa pracuje zatial’ ¢o bezi analyza na

pozadi.
e Ako signalizovat’ dobehnutie analyzy

e Co robit’ ak uz beZi analyza a editor zaznamena d’alsie zmeny pri praci so suborom.
Zhodit’ vlakno a spustit’ odznova alebo vytvorit’ d’alSie vlakna? Problém, Ze analyza by

nemusela nikdy dobehnut’ pri prili§ akénom pouzivatel'ovi.

e Ako pristupovat k lua_state, teda ako to obalit’ na strane editora

5.4 Implementacia spracovania AST pomocou LUA C API

Rozhodli sme sa do prototypu implementovat’ spracovanie abstraktného syntaktického stromu
pomocou LUA C API. Postupovali sme prepisom jednotlivych funkcii, ktoré sme nahradili

v triede TreeElement za ich dynamicku verziu.
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Ukazka funkcie ktora vracia deti (children) aktudlneho elementu v zasobnika a uklada ich do

listu.

QList<TreeElement*> Analyzer::getElementChildrenAST () {
QList<TreeElement*> children;
int limit = getCountElementChildrenAST() ;
1if( limit > 0 ) {
TreeElement* child;
for(int i = 0; i < limit ; i++ ) {
lua next (L, -2); //)
QString nodeName;
nodeName = getChildAST () ;
bool paired = false;
if (pairedTokens.indexOf (nodeName, 0) >= 0)

{

iterate on child

paired = true;
}

child = new TreeElement (nodeName,

selectableTokens.contains (nodeName),
multiTextTokens.contains (nodeName) ,
false, paired);
if (floatingTokens.contains (nodeName))
child->setFloating (true) ;
child->analyzer = this;
children.append (child) ; //! add children to list
}
lua pop(L, 1);
lua pushnumber (L, 1);
}
return children;

}

Pomocna rekurzivna funkcia na zistenie jednotlivych deti.

QString Analyzer::getChildAST () {
QString child;
if (lua_isstring(L, -1)) {
child = QString(lua_ tostring(L, -1));
lua pop (L, 1);
telse(
lua pushnil (L) ;
while (lua next (L, -2) != 0)
{
if (lua_isstring(L, -1))
child = getChildAST
break;
lelse(
child = getChildAST () ;
lua pop(L, 2);

{
()7

}
}
lua pop(L, 2);
}

return child;
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Nahradenie za dynamicku verziu funkcie v triede TreeElement.

QList<TreeElement*> TreeElement::getChildren () const

{
if (DYNAMIC)
return this->analyzer->getElementChildrenAST () ;

else
return children;

}
Podarilo sa ndm implementovat vacSinu funkcii v triede TreeElement. Neskor sa vSak
testovanim priSlo na problém spdtného vnarania sa na predchadzajuce elementy,

predovsetkym z dovodu reprezentécie len jedného lua_state stavu.
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6 Testovanie

V ramci tejto Casti st popisané spdsoby testovania a navrhnuté jednotlivé akceptacné testy.

6.1 Akceptacné testy pre overenie funkcionality

Sluzia na overenie jednotlivych funkcionalit systému.

Tab. 12 Akceptacny test funkcionality Undo/redo

Rozhranie dokument ID testu 01
Utel testu Overenie funkcionality Undo/redo ID UC 13
Vstupne podmienky Otvoreny dokument obsahujtci text (zdrojovy kod)

Vystupné podmienky Dokument je po editovany a vyuziti funkcie Undo/redo v povodnom stave
Krok Akcia Ocakavana reakcia Skuto¢na reakcia

1. Vymaz Cast’ textu Z dokumentu je vymazana Cast’ textu.

2. Stla¢ ctrl + z (undo) Vymazany text je obnoveny.

3. Napis cast’ textu V dokumente pribudol text.

4. Stla¢ ctrl +y (redo) Novy text je odstraneny.

Uroveii splnenia testu Musi — Malby — Mehel by

Poznamka -

Tab. 13 Akceptacny test funkcionality skratiek (shortcuts)

Rozhranie hlavne menu ID testu 02
Utel testu Overenie funkcionality skratiek ID UC 15
Vstupne podmienky Nakonfigurované skratky

Vystupné podmienky Vykonanie prislusnej funkcionality podla nastavenej skratky

Krok Akcia Ocakavana reakcia Skutoéna reakcia

1. Dopis text do dokumentu V dokumente pribudol text.

2. Stlag ctrl + s (save) Zobrazi vol'bu uloZenia dokumentu.

3. Stlac ctrl + q (quit) Ukon¢i sa editacia a program.

4. Stla¢ ctrl + <znak> Vykona prislusnu funkcionalitu.

Uroveii splnenia testu Musi — Malby — Mehel-by

Poznamka -

Tab. 14 Akceptacny test funkcionality 2 médov editora

Rozhranie dokument ID testu 03
Utel testu Overenie funkcionality 2 modov editora ID UC 14
Vstupne podmienky Otvoreny dokument obsahujtci text (zdrojovy kod)
Vystupné podmienky Prepnuty méd editovania dokumentu
Krok Akcia Ocakavana reakcia Skuto¢na reakcia
1. Ozna¢ dokument Dokument je oznafeny (zvyrazneny
okraj).
2. Stla¢ alt + l'avé tlacidlo Nastala zmena modu editovania
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mysky dokumentu. Editovany text je bez
zmeny.
4. Dopis text do dokumentu V dokumente pribudol text.
5. Stlac¢ alt + l'avé tlacidlo Editovanie sa preplo na povodny mad.
mysky V dokumente su vsetky zmeny.
Uroveii splnenia testu Musi — Mal-by — Mehol by
Poznamka -
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7 Zhodnotenie a navrhy do dalSej fazy riesenia

V projekte sme analyzovali existujuce rieSenia podobnych systémov a tieZ vhodné
technologie. Navrhli sme viaceré spdsoby ako implementovat’ jednotlivé funkcionality pre
systém, pre ktoré sme vykonali viacero experimentov. Do prototypu sa nam podarilo
implementovat’ Cast’ funkcionality dynamického spracovania abstraktného syntaktického
stromu, funkcionalitu dvoch moédov a nativne undo/redo v druhom mode editovania. Kedze
tento projekt vyvijame iterativnym spdsobom vyvoja, tato faza projektu slizila hlavne na
dokladnu analyzu a navrh jednotlivych Casti systému. V d’alSej faze projektu sa preto budeme

venovat predovsetkym implementovaniu navrhnutych funkcionalit a dokladnému testovaniu.

7.1 Navrhy pre optimalizaciu rieSenia

7.1.1 Optimalizacia paralelizmu

V d’alSej faze bude nutné implementovat’ paralelizmus aj na strane Lua jazyka, ked'Ze ide
o skriptovaci jazyk, kedy ak by sa pracovalo len sjednym /lua state nad ktorym bude
spustana analyza a medzitym pridu aj d’alSie aktualizacie, tak budu d’alSie prikazy ¢akat’, kym
nespracuje skor zavolanu analyzu. Je to dané spdsobom prace skriptovacich jazykov, kedy

kym neskocni jeden proces, tak nezac¢ne d’alsi.

Tento spdsob nam umozni prestat’ uvazovat’ o vytvoreni nového /ua state na strane C++ ale
rovno zavolat’ v Lua analyzu a v ramci nej nechat’ paralelne spracovat’ text. Bol by mensi
problém so zamenenim analyzy a obsahu AST stromu avSak bolo by nutné oSetrit

spracovanie inych konov, ktoré st na strane Lua.

7.1.2 Optimalizacia spracovania AST

Najoptimalnej$im spracovania abstraktného syntaktického stromu je jeho priame spracovanie
a namapovanie na C-S§truktiru pomocou LUA FFI priamo pri spracovani kniznicou LPeg.
Takéto rieSenie vSak vyzaduje rozsiahli zasah do tejto kniznice pri zachovani jej

funkcionality. Pre aktualne potreby by malo byt postacujuce dokoncenie rieSenia s LUA C

APIL.
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8 Zapracovanie nedostatkov Specifikacie a navrhu v LS

Na zaklade vlastnej empirie ziskanej pocas prac na zimnom semestri sme sa rozhodli urcité
atributy projektu pozmenit. Zmenou presla nielen architektira programu a dizajn
pouzivatel'ského prostredia, ale prepracované boli aj niektoré uz implementované funkcné
prvky editora. Taktiez vznikli aj nové poziadavky na funkcionalitu, ktoré sa skor tykaja

vizualneho pouzivatel'ského dojmu z editora.

8.1 Priority rieSenia

Na zéklade novych poziadaviek a zistenych nedostatkov museli byt ako priority rieSenia
prace v LS stanovené dva smery. Na jednej strane vyplynula potreba optimalizacie uz
implementovanych funkénych cCasti editora ako je napr. lepSie spracovanie AST stromu
alebo paralelizmus. Na strane druhej bola presadend snaha o prerobenie a obohatenie
pozivatel'ského rozhrania, ¢im by editor dostal ovel'a profesionalnejsi vzhl'ad, ktory k redlne

pouzivanej aplikacii jednoducho patri.

Priority rieSenia v LS

Optimalizacia CORE Novy dizajn Ul pre
funcionalit editora zlepSenie prace s editorom

Obr. 7 Priority rieSenia v LS - smery
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9 Zmeny v navrhu systému a pouzivatelskom prostredi

9.1 Nova architektura editora

Architekturu programu sme sa nakoniec nerozhodli implementovat’ na klasickom trojvrstvom
principe, avSak zvolili sme Struktaru, ktora odzrkadl'uje princip open-source projektov.
Stucasné architektira programu je zobrazena na Obr. 8 ako blokova schéma programu, kde

jednotlivé balicky reprezentuji sémantické zoskupenie stborov vramci hierarchickej

Struktlry.
TROLLEDIT
SRC
w.Cag, A
Source code
RES
Wi, i, e
Resources
Dependencies
aSubMogu » aSubModul »
Lpeg Lua.it
DATA
il g filesy wlug fign
Grammears Config_app
. Lt frlaw . Xt Kigw .yl frlen . T flen
Cmakelist License travis Rzadme

Obr. 8 Blokova schéma programu
V zlozke SRC su umiestnené vsetky zdrojové kody programu t.j. .cpp a .h subory, ktoré tvoria
logiku programu. Zlozka RES obsahuje vSetky obrazky, ikony a pomocné stbory, ktoré
program vyuziva. Zlozka DEPENDECIES obsahuje submoduly pre externé projekty Lpeg,
Lualit, ktory stahuje ako repozitare projektov a teda vzdy pracujeme s novou verziou kniznic.

Zlozka DATA obsahuje jednotlivé gramatiky programu napisané v jazyku Lua a podla
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potreby dalSie konfiguracné subory, napr. pre definovanie Stylov aplikacie pomocou CSS,

alebo pouzivatel'om definované skratky.

Posledny balicek obsahuje subory, ktoré nie st umiestnené v zZiadnej zlozke. Subor
CmakeList sluzi pre zostavenie programu. Subor License je klasicky textovy subor, ktory
obsahuje MIT licenciu. Stbor .travis.yml obsahuje skript pre buildovaci néastroj Travis CI'.
Stbor Readme.md obsahuje popis aplikacie a navod ako zostavit' program umiestneny

v repozitari na portali https://github.com/Innovators-Team10/TrollEdit.

9.2 Novy dizajn Ul

Co sa tyka hierarchického rozdelenia okien programu, ten je rovnaky ako v zimnom semestri,

akurat sa vyrazne zmenil dizajn celej aplikéacie od loga programu az po jednotlivé ikony.

Trolledity)

text editor with graphical el

Obr. 9 Novy splashScreen

O | & startpage

hick \) AR
B+ —IT'O“EdIt )- 7

New way of source code ccliting

Obr. 10 Novy dizajn hlavného okna aplikacie

! http://travis-ci.org/#!/Innovators-Team10/TrollEdit/builds
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H
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#include<stdio.h>
a B B Note3.pn,
int main({int argc, char *argv[] ) { png
return 0;:
}
] i v AT f«_—E]H

Obr. 11 Pracovnd plocha aplikacie

9.3 Implementacia Multi-tab rozhrania do editora

V povodnej aplikacii TrollEdit bolo pouzivatel'ské rozhranie iba v jednom okne bez tabov
a velmi rychlo vznikla poziadavka mat’ tychto tabov viacero. Preto bolo zakomponované
multi-tab rozhranie ako ho maja tradicné editory alebo web prehliadace. Na Obr. 11 je
znazorneny UML diagram pdvodného rieSenia. MainWindow je hlavné okno aplikacie. To
obsahuje jeden DocumentScene, ktory reprezentuje jeden pracovny priestor, v ktorom moze

byt otvorenych viacero suborov reprezentovanych triedou BlockGroup.

E| Mainwindow

1

1
E| DocumentScene

1
1,.*

] BlockGroup

Obr. 12 UML diagram povodného riesenia
Toto riesenie bolo potrebné prerobit’ takym spésobom, aby v hlavnom okne bol jeden widget v ktorom
bude mozné mat otvorenych viacero tabov. Kazdy tab potom obsahuje jeden DocumentScene s

viacerymi BlockGroupami. UML diagram nového rieSenia je hierarchicky znazorneny na Obr. 12.
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E| MMainWwindow

1

1
= gTrabwidget

1

-

E QGraphicview
1

1
— DocumentScene

1

u Erie
= BlockGroup

Obr. 13 UML diagram nového riesenia
Pri implementécii MultiTab rieSenia sme pouZili priamo Qt triedu QTtabWidget, ktora v sebe
implementuje vSetku zdkladnu funkcionalitu zatial’ postacujiicu pre potreby TrollEditu. Ak by
sme vSak chceli implementovat’ SpecifickejSiu poziadavku ako napriklad zatvorenie tabu po
stlaceni stredného tlacidla mysi, pridanie znaku * pred ndzov tabu ak sa v iom nachadzaju
editované stbory atd’., tak by bolo potrebné vytvorit’ vlastnu triedu, ktord by dedila od triedy
QtabWidget. Preto sme od toho nateraz upustili.

Pocas implementicie sme ale narazili na problém s funkénostou existujucich funkeii.
Problém bol v tom, Ze pdvodné rieSenie pocitalo iba s jednou globalnou triedou
DocumentScene, ktord bola dostupna ako private atribut v triede MainWindow. Jednotlivé
akcie (funkcie) ako napr. vytvorenie nového suboru ¢i ulozenie siboru, by sme mohli rozdelit
na 2 Casti. Prva cast’ st funkcie naviazané na MainWindow (novy subor, otvor stubor, zatvor
aplikéciu atd’.). Druhd Cast’ naviazana na dokument scénu, resp. na nejaky konkrétny subor
(zatvor subor, uloz subor...). Akcie v tejto druhej skupine boli pdvodne naviazané systémom
signalov a slotov na dovtedy jedint scénu. V novom rieseni je uz ale viacero scén, takze ich
nie je mozné priamo staticky naviazat' cez connnect. Preto sme toto rieSenie obalili
wrapperom tychto funkcii. Akcie su teda naviazané na tieto funkcie, v ktorych sa dynamicky

vybera aktualna scéna, pre ktori sa ma vybrana akcia vykonat'.

void MainWindow: :closeGroupWrapper () {
getScene () ->closeGroup (getScene () —>selectedGroup()) ;

}
void MainWindow: :revertGroupWrapper () {
getScene () —>revertGroup (getScene () ->selectedGroup()) ;

}
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void MainWindow: :saveGroupWrapper () {
getScene () ->saveGroup (getScene () ->selectedGroup () -

>getFilePath (), 0, false);

}

void MainWindow: :saveGroupAsWrapper () {
getScene () ->saveGroupAs (0) ;

}

void MainWindow: :saveAllGroupsWrapper () {
getScene () ->saveAllGroups () ;

}

void MainWindow: :saveGroupAsWithoutDocWrapper () {
getScene () ->saveGroupAsWithoutDoc (0) ;

}

void MainWindow: :closeAllGroupsWrapper () {
getScene () —->closeAllGroups () ;

}

void MainWindow: :showPreviewWrapper () {
getScene () ->selectedGroup () —>changeMode (actionlList) ;

}

void MainWindow: :cleanGroupWrapper () {
getScene () ->cleanGroup (0) ;

}
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10 Optimalizacia a dalsSia implementacia funkcii editora

V ramci implementdcii sa viac najmd pokracovalo v rozsirovani existujucich funkcii a neskor

aj ich optimalizovanim pre ¢o bezproblémovy a hladky beh editora.

10.1 Implementacia spracovania AST pomocou Lua C API

V triede TreeElement pribudli 2 premenné typu int a pole int[], pomocou ktorych vieme urcit’

presnu polohu v AST na strane Lua.

Nastavenie elementu na presntl polohu v AST realizujeme takto.

TreeElement *Analyzer::setIndexAST(int deep, int *nodes) {
return getElementAST (deep, nodes);

}

Pri praci s TreeElementmi v C++ pred nejakou operaciou kontrolujeme lokaciu a podla

potreby ju nastavime na taka akt potrebujeme.

void Analyzer::checkLocationAST (int deep, int* nodes) {

if( deep != glob deep AST ){ //!
setIndexAST (deep, nodes);
return;

}
for(int 1 = 0; 1 < deep-1; i++){

if(nodes[i] != glob nodes ASTI[i]) {
setIndexAST (deep, nodes);
return;

Ukazka funkcie ktoréd vracia deti (children) aktualneho elementu v zdsobnika a uklada ich do

listu.

QList<TreeElement*> Analyzer::getElementChildrenAST () {
QList<TreeElement*> children;
int limit = getCountElementChildrenAST () ;
if( limit > 0 ) {
int last = lua tonumber (L, -1);
for(int i = 0; i < limit; 1i++) {
lua next(L,-2);
lua pushnil (L) ;
lua next(L,-2);
children.append (getElementAST()); //! add children to list
lua pop (L, 3);
}
lua pop(L,1);
lua pushvalue (L, last) ;
}

return children;

Nahradenie za dynamicku verziu funkcie v triede TreeElement.
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QList<TreeElement*> TreeElement::getChildren () const
{
if (DYNAMIC) {
this->analyzer->checkLocationAST (this->local deep AST, this-
>local nodes AST);
return this->analyzer->getElementChildrenAST () ;
lelse(
return children;

}

Podarilo sa ndm implementovat’ va¢sinu funkcii v triede TreeElement. V dynamickej verzii
sme doplnili aj reanalyzovanie elemetu ajeho nahradenie v lua stacku. Pri integracii sa
vyskytli problémy vyplyvajice najmd z vel'mi tuzkej previazanosti tried TreeElementu a
Block pri reanalyzovani, tiez pri manipuldcii s dokumentacnymi blokmi. Zakladné

vykreslenie a vizualizacia stromu funguje.

10.2 Optimalizacia konfiguraénych nastaveni cez Lua

Pre lepSiu modularitu programu sme implementovali konfiguratny subor vo forme Lua
skriptu. Takyto pristup mé viacero vyhod predovsetkym je to vyuzitie skriptovacieho jazyka,
ktoré umozni vytvaranie aj sofistikovanejsie konfiguracnych nastaveni.

void loadConfig(lua State *L, const char *fname, int *w, int *h, QString
*style) {
if (lual loadfile(L, fname) || lua pcall(L, 0, 0, 0))
gDebug () << "cannot run config. file: " << 1lua tostring(L, -1);
lua getglobal (L, "style");
lua getglobal (L, "width");
lua getglobal (L, "height");
if (!lua isstring(L, -3))
gDebug () << "'style' should be a string\n";

if (!lua_isnumber (L, -2))
gDebug () << "'width' should be a number\n";
if (!lua isnumber (L, -1))

gDebug () << "'height' should be a number\n";
*style = lua tostring(L, -3);
*w = lua_ tointeger (L, -2);
*h = lua_ tointeger (L, -1);

Funkciu s$tylovania sme previazali do jazyka Lua.

static int setstyle(lua State *L) {
QString str = lua tostring(L, 1); /* get argument */
window->setStyleSheet (str);
return 0; /* number of results in LUA*/

Nacitanie konfiguraéného suboru z priecinku data.

// Load config from config app.lua
lua State *L = lual newstate();
lual openlibs (L) ;

int width, height; QString style;
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const QString CONFIG DIR = "/../share/trolledit";

QDir dir = QDir (QApplication::applicationDirPath() + CONFIG DIR);

QFilelInfo configFile (dir.absolutePath () + QDir: :separator () +
"config app.lua");

window = reinterpret cast<MainWindow*> (&w) ;

lua register (L, "setgtyle", setstyle) ;
loadConfig (L, gPrintable(configFile.absoluteFilePath()), &width, &height,
&style) ;

10.3 Implementacia gramatiky pre ToDo list

Pri implementacii sme vychddzali z existujucej gramatiky XML, ktora poskytuje dobry zaklad
na navrh gramatiky pre ToDo list. Z gramatiky boli odstranené niektoré zbytocné casti ako
napriklad deklaracia XML hlavicky alebo atribty. Gramatika bola rozSirend o nové vzory,
ktoré sluzia na zachytdvanie udajov o jednotlivych tilohach a na rozliSenie medzi hotovymi

ulohami a ulohami, ktoré este treba spravit’. Patria sem elementy: todolist, done a undone.

Pre gramatiku bol pridany vzorovy priklad. v tvare:

<todolists>
<done>
<todolist>
<title>TODOl</title>
<author>Author</author>
<creationDate>date</creationDate>
<description>description</description>
</todolist>
<todolist>
<title>TODO2</title>
<author>Author</author>
<creationDate>date</creationDate>
<description>description</description>
</todolist>
</done>
<undone>
<todolist>
<title>TODO3</title>
<author>Author</author>
<creationDate>date</creationDate>
<description>description</description>
</todolist>
</undone>
</todolists>

10.4 Implementacia textovych operacii

Pri implementacii sa v prvom rade zameriavame na pracu s textom, pri€om az potom mozZeme
rieSit’ veci tykajlice sa prace s textom v blokoch. V aktudlnom stave ma pouzivatel' pocas
prace s editorom moznost prepnut sa do textového moédu. V tomto mode si k dispozicii

Standardné funkcie textového editora medzi ktoré patri napr. zname Undo/Redo.
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10.4.1 Implementacia Undo/Redo

Zakladom pre implementaciu textového modu je trieda QGraphicsTextItem, ktora predstavuje
element na zobrazenie formatovaného textu. Tato trieda poskytuje funkcionality Undo a
Redo, ktoré su pristupné bud’ pomocou kontextového menu, alebo pomocou Standardnych
klavesovych skratiek (Ctrl + Z, Ctrl + Y). Funkcionalita bola zapracovana aj do menu
aplikécie.

V triede TextGroup boli implementované nasledujuce funkcie, ktoré vytvaraju prislusné

udalosti a nasledne zavolaju funkcie na spracovanie tychto udalosti.

void TextGroup: :undo ()
{
QKeyEvent *event = new QKeyEvent (QEvent::KeyPress,Qt::CTRL + Qt::Key Z,
Qt::NoModifier);
keyPressEvent (event) ;
}

void TextGroup: :redo ()
{
QKeyEvent *event = new QKeyEvent (QEvent::KeyPress,Qt::CTRL + Qt::Key Y,
Qt::NoModifier) ;
keyPressEvent (event) ;
}

Nasledujuce funkcie implementuju spristupnenie Undo/Redo z menu aplikacie.

void MainWindow: :undo ()

{
getScene () ->selectedGroup () —>getTextGroup () —>undo () ;

}

void MainWindow: :redo ()

{
getScene () ->selectedGroup () —>getTextGroup () —>redo () ;
}

10.4.2 Implementacia d’alSich textovych operacii

Medzi zakladné funkcionality kazdého editora okrem Undo/Redo patria aj copy, paste, cut,
delete a selectAll. Spominana trieda QGraphicsTextltem poskytuje aj tie funkcionality
rovnakym spdsobom ako Undo/Redo.

Priklad implementacie funkcionality Copy:

void TextGroup: :copy ()
{
QKeyEvent *event = new QKeyEvent (QEvent::KeyPress,Qt::CTRL + Qt::Key C,
Qt::NoModifier);
keyPressEvent (event) ;
}

void MainWindow: :copy ()

{
getScene () ->selectedGroup () —>getTextGroup () —>copy () ; }
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10.5 Implementacia paralelizmu

V ramci zavedenia paralelizmu do editora atak umoznenia pohodlnejSej prace bol lepsie
premysleny a zmeneny pristup k tomu ako bude paralelizmus pouzity. Tato zmena a aj
optimalizacia paralelizmu vyplynula aj z otazky, €o robit’ ked’ sa editor snazi pouzit’ paralelné
analyzovanie textu po prvykrat. Samotnd kompletnd analyza aktudlneho textu v subore je
zlozitej$i proces pozostavajuci z dvoch vicsich celkov. Prvym znich je analyza textu za
pomoci Lua, ktord za pomoci gramatiky vytvori Strukturu, ktora je neskor interpretovana ako

AST strom. Druhd Cast’ nasledné vykonava prepocitanie kazdého analyzovaného bloku.

Analyzer:getSnippet |

BlockGroup::getStatusBar |

BlockGroup:iupdateAllinThread |

BlockGroup::analyzeAll

I
BlockGroup:: setRoot |
\E”'ikGruup::updateAIIInMaster
| BlockGroup::analazyAllinThread
Analyzer:analyzeFull

BlockGroup::analazyAllinkdaster |

Obr. 14 Nova Struktura pre implementovanie paralelizmu

10.5.1 Paralelné spracovanie kompletnej analyzy textu
Analyza textu ako je zobrazend na Obr. 13 je zalozena na dvoch moznostiach ateda aj
funkciach. Vo funkcii analyzeAll prebieha len rozhodovanie, ¢i sa ma analyza textu vykonat
prvy krat (otvorenie alebo vytvorenie stboru), alebo modze bezat’ na pozadi. Prvy spdsob
analyzy funguje rovnakym spdsobom ako bez paralelizmu. Druhy spdsob uz bezi vo vldkne.
Na nasledujucej ukazke je znazornena hlavna Cast’ rozhodovania vo analyzeAll. Zostali sme
pri pouziti kniznice QtConcurrent, ktora ndm zabezpeci beh funkcie vo vldkne bez véicsieho
zasahu. Stc¢asne sa pri tomto rozhodovani priamo urcuje aj aky typ aktualizovania blokov sa
pouZzije.
if (runParalelized == true) {

bool connected = QObject::connect (&watcher, SIGNAL (finished()), this,

SLOT (updateAllInThread())) ;
future = QtConcurrent::run(this, &BlockGroup::analazyAllInThread, text);

watcher.setFuture (future); //! aZz tu sa spusti funkcia vo vlékne

}

else {
TreeElement* rootEl = analazyAllInMaster (text);
updateAllInMaster (rootEl); 1}
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10.5.2 Paralelné spracovanie update blokovej Struktiry

Na podudovanie na zaklade testovania je prave tato ast’ pre update blokov z hl'adiska dizky
trvania tou kl'aicovou. Hlavnym problémov a to nie len paralelizmu je spdsob akym pracuje
editor s blokmi a Struktirami, na ktoré si drzi priamo referenciu do pamite, ktora je potrebné
posielat’ medzi vlaknami. Ked'Ze je tato Cast’ prili§ komplexna pre jej samostatné spustenie vo
vlakne na pozadi, bolo treba zaviest’ iny paralelny pristup atym sa stalo rozdelenie
spracovania v ramci cyklu na viacero vldkien. Rozdelenie na funkcie wupdateAlllnThread
a updateAllInMaster z Obr. 13 je vyznamné z hladiska spdsobu pristupu a spracovania

vysledkov analyzovaného textu.

mutex.lock() ;

//! vysledok berie zo zdielane] premennej

Block *newRoot = new Block(groupRootEl, 0, this);
mutex.unlock () ;

//! nastav novy korenovy blok (root) a update celej StruktiGry pod nim
setRoot (newRoot) ;

Podstatna cast’, kde sa vykonava update celej blokovej Struktiry pod novym korefiom je
vcelku jednoducha.

QList<DocBlock*> docBlocksList = docBlocks () ;
//! ToDo: Divide foreach loop and objects in docBlocks into more threads.
foreach (DocBlock *dbl, docBlocks()) {
dbl->updateBlock (false) ;
}

Ako vidime, vyskytuje sa tu problém v vyuzivanim referencii, s ktorymi ma kniznica
QOtConcurrent aspon zatial’ problémy. Preto bolo aj viacero moznosti, ktorymi sme sa uberali:
1. Pouzit’ priamo QtConcurrent pre rozdelenie spracovania listu do viacerych vlakien

nad listom docBlocksList

QtConcurrent: :blockingMap (docBlocksList, this->updateDocBlockInMap())

2. Pouzit Struktiru OSharedMemory, ktora reprezentuje objekt drziaci referenciu

QList<QSharedPointer<DocBlock> *> pointerList;

Po tejto sérii nevydarenych pokusov sme sa nakoniec rozhodli pouzit’ technolégiu OpenMp,
ktora je nezavisla od Qt adobre fungujuca aj v multiplatformovom prostredi. Problém,
ktorym eSte miestami Qt framework trpi je relativne neddvne zavedenie paralelizmu, ¢o

znamena, ze eSte ma svoje problémy.
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11 Overenie vysledku

Cielom testovania tohto produktu bolo odhalenie chyb, tak aby beh aplikdcie bol bez
problémov apraca stou bola dostatocne komfortnd. Pocas implementovania aplikécie
prebiehalo testovanie pomocou testovacieho planu. Pomocou nasledujucich akceptacnych

testov sme overili funkcionalitu a spravne reakcie aplikacie.

Tab. 15 Akceptacny test funkcionality Undo/redo

Rozhranie dokument ID testu Ol
Ukel testu Overenie funkcionality Undo/redo ID UC 13
Vstupne podmienky Otvoreny dokument obsahujtci text (zdrojovy kod)

Vystupné podmienky Dokument je po editovany a vyuziti funkcie Undo/redo v pdvodnom stave

Krok Akcia Ocakavana reakcia Skuto¢na reakcia

1. Vymaz Cast’ textu Z dokumentu je vymazana Cast’ textu. Z dokumentu je vymazany text.
2. Stla¢ ctrl + z (undo) Vymazany text je obnoveny. Vymazany text je obnoveny.
3. Napis Cast’ textu V dokumente pribudol text. V dokumente pribudol text.
4, Stla¢ ctrl +y (redo) Novy text je odstraneny. Novy text je odstraneny.
Uroveii splnenia testu Musi — Mal-by — Mehel by

Poznamka -

Tab. 16 Akceptacny test funkcionality skratiek (shortcuts)

Nazov Pouzitie skratiek (shortcuts)
Rozhranie hlavne menu ID testu 02
Ukel testu Overenie funkcionality skratiek ID UC 15

Vstupne podmienky Nakonfigurované skratky
Vystupné podmienky Vykonanie prislu$nej funkcionality podl'a nastavenej skratky

Krok Akcia Ocakavana reakcia Skuto¢na reakcia

1. Dopis$ text do dokumentu V dokumente pribudol text. V dokumente pribudol text.

2 Stlac ctrl + s (save) Zobrazi vol'bu ulozenia dokumentu. Dokument je ihned’ ulozeny.

3. Stla¢ ctrl + q (quit) Ukon¢i sa editacia a program. Ukoncila sa editacia.

4 Stla¢ ctrl + <znak> Vykona prislusna funkcionalitu. Vykona prislusnu
funkcionalitu.

Uroveii splnenia testu Musi — Mal-by — Mehel by

Poznamka -

Tab. 17 Akceptacny test funkcionality 2 médov editora

Rozhranie dokument ID testu 03
Ukel testu Overenie funkcionality 2 modov editora ID UC 14
Vstupne podmienky Otvoreny dokument obsahujtci text (zdrojovy kod)

Vystupné podmienky Prepnuty mod editovania dokumentu

Krok Akcia Ocakavana reakcia Skuto¢na reakcia

1. Ozna¢ dokument Dokument je oznafeny (zvyrazneny Dokument je oznaceny
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okraj). (zvyrazneny okraj).

2. Stla¢ alt + l'avé tlacidlo Nastala zmena modu editovania Nastala zmena modu editovania

mysky dokumentu. Editovany text je bez dokumentu. Editovany text je
zmeny. bez zmeny.

4. Dopis text do dokumentu V dokumente pribudol text. V dokumente pribudol text.

5. Stlac¢ alt + l'avé tlacidlo Editovanie sa preplo na povodny mdéd. Editovanie sa preplo na
mysky V dokumente su vSetky zmeny. povodny mdd. V dokumente st

vSetky zmeny.
Uroveii splnenia testu Musi — Mal-by — Meheol by
Poznamka -

Pocas projektu sme sa museli vysporiadat’ s viacerymi chybami, niektoré z nich plynuli zo
zlého dizajnu predchadzajiiceho rieSenia. Preto bolo potrebné do urcitej miery prebudovat
architektaru, predovSetkym otvaranie suborov do tabov. Okrem toho je potrebné dokoncit

manazéra medzi dvomi modmi, tak aby bola zabezpecena ich plnd kompabilita.

V projekte bola zaintegrovana podpora kontinudlnej integracie pomocou Travisu, ¢o prispelo
k automatickej integracii projektu. Ten bol hned’ po komitnuti do hlavného repozitara
vybuildovani. Projekt sme testovali podl'a testovacich planov a akcepta¢nych testov. Okrem
manualneho testovania v tomto projekte by bolo vhodné doplnit’ aj systémy na automatické
testovanie, ktoré by prispelo k lepSej kvalite. Ako jedna z moZnosti sa javi integrovat’ CTest

a pri integracii projektu spustiat’ tieto testy.
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12 Zaver

Hlavnym cielom tohto projektu bolo pokracovat’ vo vyvoji textového editora obohateného
o grafické prvky snazvom TrollEdit a vylepSovat ho vo viacerych smeroch. V zimnom
semestri sme sa zaoberali analyzou existujiceho rieSenia ajeho upravou v podobe
refaktorizacie. Dalsim délezitym krokom bola $pecifikdcia hlavnych funkcionalit resp.
vylepSeni ktoré chceme v rdmci projektu realizovat. Na zéklade tejto Specifikacie sme sa
pustili do analyzy, navrhu aexperimentovania jednotlivych funkcionalit. Medzi
najdodlezitejsie Specifikované funkcionality patri: implementacia 2 modov editora (graficky
mod atextovy mod) aintuitivne prepinanie medzi nimi, zakladné textové operdcie
a zvyraziiovanie syntaxe v textovom mode, vylepSenie spracovania AST (Abstract Syntax

Tree), zavedenie paralelizmu a vylepsenie grafického pouzivatel'ského rozhrania.

V letnom semestri sme sa zamerali na implementiciu Specifikovanych a navrhnutych
funkcionalit aich nasledné overenie. NajvyraznejSie zmeny nastali v grafickom rozhrani
aplikécie, ktoré dostalo uplne novu tvar. Dalej z pohladu pouZitelnosti aplikacie dolezitym
krokom bola implementacia textového mddu spolu so zékladnymi textovymi operdciami.
Vysledkom projektu je teda textovy editor obohateny o grafické prvky, ktory je blizko

k redlnemu nasadeniu do praxe.

12.1 Napady na d’alSie vylepSenie

Pocas riesenia projektu sme sa sustredili na vytvorenie pouzitelnej aplikacie a preto sme sa
zamerali na funkcionality, ktoré st ztohto pohladu klu¢ové. Okrem tychto funkcionalit
mame aj d’alSie ndpady ako aplikdciu vylepsit. Nasledujici zoznam obsahuje funkcionality,

ktoré sme nestihli realizovat’ resp. povazujeme za zaujimaveé:
e Pokrocilejsia praca s dokumentacnymi blokmi
e Podpora refaktorizacie
e Podpora d’alSich jazykov
e Modularizacia aplikacie

e Semantické vyhladavanie (vyhladavanie vSetkych funkcii, vyhladavanie vSetkych

konstant, atd’ ...)
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12.2 Ziskané vedomosti a skusenosti

Praca na timovom projekte nas obohatila vo viacerych oblastiach. Cielom predmetu timovy
projekt, ako aj jeho ndzov naznacuje, je naucit’ sa pracovat’ v time a vytvorit pouzitel'ny
produkt. Co sa tyka timovej prace, tak sme ziskali dolezité skiisenosti s riadenim timu a so
spolupracou v time. Osvojili sme si pracu s nastrojmi na riadenie projektov a uvedomili sme

si ich dolezitost’.

Vedomosti a skusenosti technického charakteru sme ziskali pri vyvoji produktu. Tu sme sa
stretli s programovacimi jazykmi a technolégiami ako: C++, QT Framework, Lua, LPeg.
Okrem toho sme ziskali sklisenosti s ndstrojmi na manazovanie zdrojovych kédov ako SVN

a GIT resp. s nastrojmi na automatické buildovanie a kontinudlnu integraciu projektu.

60 | Strana



Priloha A — Pouzivatel'ska prirucka aplikacie TrollEdit

A.1 Panel nastrojov

Na Obr.15 je znazorneny panel nastrojov, ktory obsahuje zdkladné funkcionality aplikacie.

|} Unknown5 — TrollEdit

Eile Edit Yiew Tools Help

BENREE® X[ - x ONG)

Obr. 15 Panel nastrojov

Zakladny panel nastrojov poskytuje nasledujuce funkcionality (z lava do prava):

e Vytvorenie nového dokumentu

e Otvorenie existujuceho dokumentu
e Ulozenie zmien

e Zatvorenie dokumentu

e Zmena modov editora

e Zobrazenie oblasti pre tlac

e Tla¢ do PDF

e Zmena gramatiky

e Vyhladavanie

e Zmazanie vysledkov vyhl'addvania
e Zobrazenie informadcii o aplikécii

e Zobrazenie help aplikacie

A.2 Klavesové skratky aplikacie
Ctrl + N — vytvorenie nového dokumentu

Ctrl + O — otvorenie existujuceho dokumentu
Ctrl + S — uloZenie zmien

Ctrl + Q — zatvorenie aktualneho dokumentu
Ctrl + T — zmena do textového mddu

Ctrl + C — kopirovanie
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Ctrl + V —vlozenie

Ctrl + A — vyber

Ctrl + Z —undo

Ctrl + Y —redo

Ctrl + F — vyhl'adavanie

F8 — celé obrazovka

F1 —help

Alt + pravy klik — zmena mddov editora

Ctrl + pravy klik — vytvorenie komentara

A.3 Vytvorenie nového dokumentu

Pri vytvoreni nového dokumentu sa nevytvara Uplne prazdny dokument, ale dokument
obsahujuci kus zdrojového kédu (snippet) daného jazyka. Vytvorit’ novy dokument je mozné
viacerymi sposobmi. Bud’ pomocou panelu nastrojov (Obr.16) alebo pomocou hlavného
menu: File -> New. NajrychlejSim spoésobom vytvorenia nového dokumentu je pomocou

klavesovej skratky Ctrl + N.

!eél Unknownl — TrollEdit

File Edit  View  Tools Help
BEREE®& [ |0 000
lcesnennic)| s 1)

- - >
B #include<stdic.h> created 10.05.2012

return 0

o

i B int main(int arge, char *argv[] ) { !

Obr. 16 Vytvorenie nového dokumentu

A.4 Prepnutie medzi dvoma modmi

Aplikacia poskytuje 2 mody na pracu s jednotlivymi dokumentmi: textovy moéd, ktory sa
sprava ak jednoduchy textovy editor a graficky mod, kde obsah dokumentu je obohateny
o grafické prvky. Prepnut medzi tymito modmi je mozné viacerymi spdsobmi: Bud’ pomocou

panelu nastrojov (Obr.17) alebo pomocou hlavného menu: File -> Edit Plain Text.
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Najrychlejsim spésobom prepnutia medzi médmi je pomocou klavesovej skratky Ctrl + T

alebo Alt + pravy klik.

Unknown2 — TrollEdit

File Edit View Tools

Help

Ba R E®E& o o0 0

¢ # startpage |:|| { Edit file as plain text |

S fecreated

}

return 0O;

H #include<stdic.h>

B int main(int argc,

10.05.2012
#include<stdioc.h>

int main(int argc,
return 0O;

B =
created 10.05.2012

char *argv[] ) {

char *argwv[] ) i

Obr. 17 Prepinanie medzi modmi

A.5 Praca v textovom mode

V textovom modde (Obr.18) sa editor sprava ako jednoduchy textovy editor. V tomto mode pre

prehl’adnost’ zdrojového kdédu je poskytované aj zvyraziovanie syntaxe. Pouzivatelovi su

dostupné vsetky zakladné funkcionality ako: kopirovanie, vloZenie, vyber textu, undo, redo ...

[T} Empty — TrollEdi

€ -] searct (xONO)

File Edit Wiew Help
I © undo Ctrl+Z
E ¥ Redo Ctrl+Y
Q i cu Ctrl+X
B Copy Ctrl+C
i Paste Ctrl+V

2 Delete Crel
Select All Ctrl+A
# Find Ctrl+F
Find Replace Ctrl+R

S /created 10.05.2012
#include<stdio.h>

int main{int argc, char *argv[] ) {
return 0;

}

Obr. 18 Praca v textovom mode
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Praca v grafickom modde

V grafickom modde (Obr.19) zobrazenie dokumentu je obohatené o grafické prvky.
Manipulacia s jednotlivymi blokmi je jednoduchd a rychla. V tomto mode je mozné editovat’
aj obsah dokumentu.

E Unknown2* — TrollEdi

File Edit  View  Tools Help
BEHEE® & oo 000

0 & Startpage |:|| tabi ﬂ‘

B #finclude<stdic.h> created 10.05.2012

return 0;|

A\ -

e g

B int main{(int argec, char *argv[] )} {. i

_________________________________________________________________________________________________________________

Obr. 19 Praca v grafickom mode

A.6 Tla¢ do PDF

Obsah dokumentu je kedykol'vek mozné vyexportovat’ do formatu PDF. Vygenerovat’ PDF je
mozné viacerymi sposobmi: Bud’ pomocou panelu néstrojov (Obr.20) alebo pomocou
hlavného menu: File -> Print PDF. NajrychlejSim sposobom vygenerovania dokumentu do
PDF je pomocou klavesovej skratky Ctrl + P.

Eile Edit View Tools Help

T ©0 0
() & Startpage B " tab1 ﬂ] _

B #include<stdic.h> created 10.05.2012

B int main (int argc, char *argv([] ) {. |
return 0; i

e

_________________________________________________________________________________________________________________

Obr. 20 Tlac do PDF
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A.7 Vyhladavanie

Aplikacia poskytuje azékladné vyhladavanie vtexte. Vyhladavanie je dostupné
prostrednictvom panelu néstrojov. Vysledky vyhladavania je mozné rychlo zmazat’ pomocou

tla¢idla na Obr.21.

B} Unknown2* — TrollEdi

File Edit WView Tools Help

BREHREEL c -~ 000

0 B startpage |:| |x tab1 m\| [ Clean search results h
Unknown2 T .
B #include<stdio.h> created 10.05.2012

B int main(int argc, char *argv[] ) { i
return 0; |

g

Obr. 21 Vyhladavanie

A.8 Praca s tabmi

Aplikacia umoziuje otvorenie viacerych suborov naraz pomocou tabov. Jednotlivé taby sa
vytvaraju pomocou tlacidla na Obr.22. Prepnutie medzi jednotlivymi tabmi je realizované

pomocou klavesovej skratky Ctrl + Tab.

[T} Unknown3* — TrollEdi

File Edit WView Tools Help

BREABRE®EAC x ONO]

@ @ statpage [ bt [ tab2 |:|| tab3 E| tab4 ]| tabs [ tabs

£

i T
H%?xml }rersionf'l.[}: encoding="UTF—B"?:}

<tag>

Obr. 22 Praca s tabmi
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A9 Zoom

Aplikacia poskytuje aj funkcionalitu zoom-in azoom-out. Tieto funkcionality st zatial
dostupné len v ramci textového moédu. Vykonavat' tieto funkcionality je mozné pomocou

hlavného menu: View -> Zoom In a View -> Zoom QOut (Obr.23).

T Unknown2* — Edi

File Edit View Tools Help

W& | Newwindow |~] 7 (OO

I Edit Plain Text Ctrl+T
O & Start [ Fulscreen = tab3 | | tab4 | tab5 [ | tabs ||

E Toolbars 3 I )

© Zoom Qut

t main{int argc, char *argv[] )} |

-

&eturn o

;

Obr. 23 Zoom-in a zoom-out

A.10 Praca s Toolbar

Aplikacia poskytuje viacero typov panelu nastrojov (Obr.24). V aktudlnej verzii st dostupné

nasledujuce typy: Basic, Format, Tools a Editor. Otvorenie a zatvorenie jednotlivych panelov

nastrojov je mozné pomocou hlavného menu: View -> Toolbars.

Empty — TrollEdi
File Edit = Tools Help
W& | Newvindow l]mr‘ OO0 a6 ©0O
: B Edit Plain Text Ctrle T :
0 i Start [] EullScreen F8
Split |

B #inc created 10.05.2012

& Zoomln
B int @ Zoom Out

return 0;

Obr. 24 Praca s toolbar
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A.11 Zoznam uloh a chyb

Aplikacia poskytuje zékladnu funkcionalitu aj na manazovanie uloh achyb pomocou

zoznamu Uloh a chyb. Tieto zoznamy st dostupné pomocou hlavného menu: Tools -> Task
list a Tools -> Bug list (Obr.25).

Task list Bug list

Obr. 25 Zoznam uloh a chyb

A.12 Strom suborov

Rovnako ako Standardné editory aj TrollEdit poskytuje strom suborov (Obr.26) na efektivnu

pracu so subormi. Zobrazit’ strom suborov je mozné pomocou hlavného menu: Tools -> File

browser.

File browser tree (>
Mame Size Type [:]
2-& C Dirive

. l.rocnik File Folder
, 2.rocnik File Folder
. 3.rocnik File Folder
B . drocnik File Folder

, l.semester File Folder

, 2.semester File Folder
, Android File Folder

Obr. 26 Strom suborov
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A.13 Help
Aplikacia poskytuje aj zakladni pomoc pri praci v podobe online help-u (Obr.27). Tento help

je dostupny pomocou hlavného menu: Help -> Help — online alebo pomocou klavesovej

skratky F1.

File Edit View Tools Help

B& R g B (<)
. @)
# start bl
o X (0 About el
Tips and Tricks

Obr. 27 Online help
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Priloha B — Prispevok na IIT.SRC 2012

TrollEdit — different approach in editing of source code
using graphic elements

Lukas TURSKY, Jozef KRAJCOVIC, Maro§ JENDREJ, Marek BRATH,
Lubo§ STARACEK, Adrian FEJES*
Slovak University of Technology in Bratislava
Faculty of Informatics and Information Technologies
Ilkovicova 3, 842 16 Bratislava, Slovakia

tp-team-10@googlegroups.com

Introduction

Today programmers use editors and IDEs that usually use simple color highlighting without any sign of graphic
enrichment features. However enriching the source code with graphic elements can be beneficial for the
understanding of the structure of given code and thus lead to better understanding of its structure and meaning
for the programmer. This basic observation is the driving idea behind TrollEdit.

TrollEdit is an experimental editor that tries to enrich source code with graphical elements for easier
manipulation. Source code editing can sometimes be very problematic especially when reviewing unknown code
that the programmer is not familiar with. Most of the time programmers are trying to familiarize themselves with
the syntax of the source and only then follow to analyze its semantic meaning. TrollEdit tries to address both of
these steps by enriching the text editor with graphical elements instead of relying on colorized text.

TrollEdit is a running project, which started as a research idea by team Ufopak. The team explored the
possibility of using abstract syntactic trees instead of simple coloring rules to enrich the presentation of source
code and its manipulation. Our goal is to further improve upon the existing core functionalities so TrollEdit can
be deployed for real development tasks.

Motivation and current achievements

The core functionality of TrollEdit is based on the use of LPeg pattern matching library. Using this library we
are able to parse source code according to its grammar into an abstract syntactic tree (AST). This data is then
used to enhance the text visualization using the Q¢ framework, which provides the needed graphic functionalities.
The proper combination of these two technologies made this editor possible by utilizing the Lua programming
language and an interface between the two technologies. For performance reasons the current project relies on
the much faster LuaJIT2 implementation.

Using a scripting language and the LPeg [1] library we are able to parse the content on any open file into
abstract syntactic three (AST) assuming that we have a matching language grammar. Created hierarchical order
is then used to visualize and interactively manipulate the structure of the program. Users can than easily control
and shift whole blocks just as they are displayed without any usual problems from conventional text editors (text
indent, selection etc.).

On top of that, the idea of literate programming by Donald E. Knuth [2] is explored as we can easily
document parts of source code with comments that can contain rich text content for documentation purposes.

Based on the work done by Ufopak we aim to optimize the generation of the AST by utilizing parallel
processing and a more efficient way to access the generated data. Among other prominent changes we are

*

Master degree study programme in field: Software Engineering
Supervisor: Dr.Peter Drahos, Institute of Applied Informatics, Faculty of Informatics and Information
Technologies STU in Bratislava
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introducing, is the ability to switch between graphically enhanced and legacy visualization of the source code. In
text-mode the editor works as any other common editor and does not interfere with the editing process so
productivity of programmers is not affected when writing code. However in second mode user gets the full
potential of enhanced editor, where edited text is represented in graphic blocks as we can see on Figure 1. This
can be interactively manipulated, printed, exported as PDF or saved for documentation.

e = T

Eile Help

[ =0 D P | D P2 | - e 0

#include <stdio.h> #include <stdio.h>

: . #include <string.h>

#include <string. hi_, #include <stdlig -h>

#include <stdlib.h> / dve ** J/dve ** [1223,74,11]

C void uvolni (zoznam **pos) {
zoznam *m, *n;

zoznam *m, *n; m= *pos;

woid uvolni (zoznam **pos) {
S

m= *pos;

]

while (m!=NULL) {

> //n ako pomocny pointer
n ako pomocny pointer n=m;

m=m->dalsi;
free(n);

hile (m!=NULL) {
@

n=m;
}

* =NULL;
;ree (n); pos

}
*pOS—NULL;

Figure 1.Visualization of two files opened in editor, one in graphic-mode and other one in text-mode.

Conclusion

All our contributions are aimed to ensure that TrollEdit will be a practical editor designated with extensibility,
efficiency and flexibility in mind. New grammar can always be added for support of new languages without any
invasion to editor. For example we can use the editor features to create a grammar for simple ToDo list
management as part of the evaluation process. The visual presentation of the editor is also extensible as it relies
on style sheets defined using the CSS format.

References
Roberto Ierusalimschy: A text pattern-matching tool based on Parsing Expression Grammars, 2009, PUC-
Rio, Rio de Janeiro, Brazil

Knuth, D.E.: Literate Programming, 1992, Stanford University Center for the Study of Language and
Information, Stanford, CA, USA, 1992.
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Priloha C — Poster na lIT.SRC 2012
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Priloha D — Systémova prirucka

Navod na instalaciu aplikacie (Windows XP/7):

Po stiahnuti balika s inStalaciou kliknutim na TrollEdit.exe sa spusti inStalacia. Na zaciatku sa

zobrazi okno inStalacie pozri obrazok 28.

TrollEdit Setup =3

Welcome to the TrollEdit Setup
Wizard

This wizard will guide you through the installation of TrollEdit.

Itis recommended that you dose all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer,

Click Mext to continue,

Euﬂ_ext:b | [ Cancel

Obr. 28 Uvodne okno instaldcie
Po kliknuti d’alej (next) je zobrazend licencia aplikdcie obrazok 29, po jej odsthlaseni

mdzeme pokracovat’ d’ale;j.
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TrollEdit Setup

Agreement

Licenze
I rOI lEd iD Please review the license terms before installing TrollEdit.

Press Page Down to see the rest of the agreement.

TrollEdit License

[

TrollEdit is licensed under the terms of the MIT license reproduced below. This means
that TrollEdit is free software and can be used for both academic and commerdal —
purposes at absolutely no cost,

Copyright (C) 2009-2012 TrollEdit,

Permission is _herel:uy grant_ed, free of u:I'm_r_gE,_b_:u any qersnn_u:ubtain_ing_ & copy cuf_this w

If you accept the terms of the agreement, dick I Agree to continue. You must accept the
agreement to install TrollEdit,

[ = Back ” I Agree l [ Cancel

Obr. 29 Licencia produktu

Nasleduje vyber miesta instalacie aplikacie obrazok 30.

TrollEdit Setup

Choose Install Location

l rOI lEd |D Choose the folder in which to install TrollEdit.

Setup will install TrollEdit in the following folder. To install in a different folder, dick Browse
and select another folder. Click Mext to continue.

Destination Folder

|C:'|,F‘r|:|gram Files{TrollEdit | | Browse. ..

Space reguired: 34.9MB
Space available: 14, 1GB

[ < Back ” Mext = l [ Cancel

Obr. 30 Miesto instalacie aplikacie
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TrollEdit Setup
Choose Start Menu Folder

I rOI lEd iD Choose a Start Menu folder for the TrollEdit shortouts,

Select the Start Menu folder in which vou would like to create the program's shortouts, You
can also enter a name to create a new folder.

TrollEdit

7-Zip ~
Accessories
Administrative Tools
Advanced SystemCare 5
Android SDK, Tools
Borland C++Builder &
Cain

com

CMake 2.3

colaR

CommView for WiFi

[ 5e not create shortouts!

[ < Back ” Install l [ Cancel

Obr. 31 Vytvorenie ikony v systéme
Po kliknuti d’alej (next) nasleduje moznost’ nazvu aplikacie v systéme a vytvorenie ikonky

obrazok 31. Nasledne je nainStalovana aplikacia a zobrazeny jej uspesny koniec.

TrollEdit Setup Bfi=10]

Completing the TrollEdit Setup
Wizard

TrollEdit has been installed on yvour computer.

Click Finish to dose this wizard.

Obr. 32 UspeSné ukoncenie instaldcie
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Konfiguracia aktuilneho projektu z repozitiara (pre Windows XP SP3/Vista/7):

Stiahnite a nainStalujte:

e MinGW - nainStaluyj mingw-get-inst-20110802.exe a stiahni verziu z aktudlnych
repozitarov

¢ (Cmake — nainstaluj cmake-2.8.5-win32-x86.exe

e QT — http://get.qt.nokia.com/qtsdk/Qt SDK Win offline vl 1 3 en.exe

— treba nainStalovat’ aj libky pre MinGW, dodatocné sa to stiahne v Maintain Qt
SDK v moznostiach balikov

e TrollEdit - insStalujte nasledovne — dajte forknit’ TrollEdit z Innovators-Team10 na svoj
ucet (https://github.com/Innovators-Team10/TrollEdit/fork) git@github.com:Innovators-
Team10/TrollEdit.git

pre Qt 4.7.4.

Treba nastavit’ Enviroments vo Windowse

PATH C:\QtSDK\Desktop\Qt\4.7.4\mingw\bin; C:\MinGW\bin; — mingw Vv
adresari pri Qt obsahuje dll kniznice pre Qt, ktoré sa pouzivajl a preto je najvhodnejSie mat’
ho v PATH prvymi

QMAKESPEC C:\QtSDK\Desktop\Qt\4.7.4\mingw\mkspecs\win32-g++

QT LIBRARIES C:\QtSDK\Desktop\Qt\4.7.4\mingw\lib

QT MOC EXECUTABLE C:\QtSDK\Desktop\Qt\4.7.4\mingw\bin\moc.exe

QT QMAKE EXECUTABLE C:\QtSDK\Desktop\Qt\4.7.4\mingw\bin\qmake.exe

pre Qt 4.8.0 a novSie
Cesty sa nastavuju podobne ako pre 4.7.4, s tym rozdielom, Ze v adresari

C:\QtSDK\Desktop\Qt\ vyberieme aktualnu verziu ktort potrebujeme

Konfiguracia projektu v QT Creator:

1. Zapneme QT Creator a pozrieme v Tools->Options->Projects->CMake premenna
"Executable" musi byt nastavena na "C:\Program Files\CMake 2.8\bin\cmake.exe"

2. Dalej v QT ako projekt otvorime CmakeLists.txt nastavite cestu pre Build do niekde
prieCinku (napr. build), klikneme "run Cmake", ak nam bude chybat cesta pre
QMAKESPEC, tak ju nastavime do argumentov "-
DQCMAKESPEC=C:\QtSDK\Desktop\Qt\4.7.4\mingw\mkspecs\win32-g++"

16 | Strana


http://get.qt.nokia.com/qtsdk/Qt_SDK_Win_offline_v1_1_3_en.exe�
https://github.com/Innovators-Team10/TrollEdit/fork�
mailto:git@github.com:Innovators-Team10/TrollEdit.git�
mailto:git@github.com:Innovators-Team10/TrollEdit.git�

3. Na bocnej liste klikneme Projects->BuildSettings->BuildSteps->Details do riadku
"Additional arguments" napiSeme "install".
4. Projekt dame buildovat, nasledné sa ndm v projekte vytvori priecinok TrollEdit
5. Na bocnej liste klikneme Projects->RunSettings
S5a. klikneme "Add Development Steps" klikneme "Make" do riadku "Additional
arguments" napiSeme "install"
5b. klikneme RunConfiguration->Add->CustomExecutable
5c. do riadku "Executable" vyberieme cestu k prie¢inku "TrollEdit\bin\trolledit" napr.
"C:\Documents and Settings\User\Desktop\TrollEdit
Innovators\TrollEdit\TrollEdit\bin\trolledit"
5d. do riadku "Working directory" vyberieme cestu k prie¢inku "TrollEdit\bin" napr.
"C:\Documents and Settings\User\Desktop\TrollEdit Innovators\TrollEdit\TrollEdit\bin"
5e. Dame buildnut.
6. Ak pustame aplikéciu, ale nejde a hlasi ze mu chybaju nejaké DLL-ka (napr. QtCore4.dll,
QtGui4.dll, libgcc s dw2-1.dll), tak ich k nej treba nahrat z cesty
"C:\QtSDK\Desktop\Qt\4.7.4\mingw\bin"

Zname bugy:
- Ak ti to stale nejde, mas pri buildovani 0% a cela kompilacia zasekne, tak skis v prieinku

"C:\MinGW\bin" duplikovat’ subor libgmp-10.dll a kopiu premenuj na libgmp-3.dll

Rychlejsie paralelne buildovanie v Qt:
1. v sekcii Projects -> Build Settings -> Build Environments treba pridat premennia SHELL
s hodnotou cmd.exe
- SHELL = cmd.exe
2. Do build prikazu potom sta¢i pridat prepina¢ -j (mdézeme rovno ¢islo povedat’ kolko
threadov ma pouzit’)
- cmare install -j

- cmake install -j 4

Navod ako vytvorit’ instalacku cez Cpack (Windows):
1. Pre windows je potrebne mat nainstalovany NSIS
2. Do C:\MinGW\bin\ treba nakopirovat’ sucasti pre Visual Studio Command Prompt, ktoré

st dodavané len s inStalaciou Visual Studia.
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Je potrebne sem pridat’ tieto Casti:

- dumpbin.exe

- link.exe

- mspdb100.d11
Daju sa ziskat’ dvoma spdsobmi:

a) ti ¢o nemaju Visual Studio si m6Zu rovno stiahnut’ s repozitara Innovators na GitHub
v sekcii Download balicek cpack.zip

b) ak mate VS tak .exe sibory sa nachadzaju v adresari c:\Program Files\Microsoft
Visual Studio 10.0\VC\bin\ a DLL niekde tam musite pohl'adat’
Ak mate vSetko nakopirované a nainstalovany NSIS, tak sta¢i v adresari, ktory si vytvara
Qt resp. Cmake pre buildovanie (ten build) v konzole zadat’ prikaz "cpack", ¢ize CMD -

> prikaz cpack - chvil’ku to potrva a vytvori to jeden .exe subor - klasickd instalacka
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Priloha E — Product Backlog

Nasledujtica tabul’ka obsahuje features, ktoré by mali byt implementované v d’alSich verziach

aplikacie TrollEdit.

Tabulka 1 Co by mohli ostatné timi dorobit do aplikicie TrollEdit

Features

Description

Category

Internacionalizacia 118n

Podpora viacerych jazykov (EN, SK, CZ, DE)

Intellisense

Import a Export nastavenia

ako napr. jazyk, tollbars, font ...

Spell checker

Zobrazenie sw. metrik

Vytvorenie snapshotu prace

Gramatiky pre jazyky

Java, C#, HTML, JS, PHP

Modularizacia projektu

Podpora refactoringu

W > W QO Ql W W W W

Legenda: A - musi byt |

B - mohlo by byt | C —ak ostane Cas
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